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3 1. Introduction

Overview
About Camera and Display Plugin

“Camera and Display Plugin” is a plugin for 
Unreal Engine for in-camera VFX shooting 
used in virtual production.
It comprises “Virtual Camera actors” for the 
pre-vis process, and an “On-set Camera 
component” and a “Camera Control Panel” 
for the on-set (shooting) process. It is 
compatible with the Sony “VENICE (CineAltaV) 
series”/”BURANO”/“FR7” Cinema Line 
cameras, “HDC‑5500”/“HDC‑5500V”/ 
“HDC‑3500”/“HDC‑3500V”/“HDC-F5500” 
system cameras, and the “Crystal LED B-series” 
and “Crystal LED VERONA (VP-series)” large, 
high-definition LED displays.

Virtual Camera actor

Sony Virtual Camera actor is a camera actor 
for Unreal Engine, designed as a digital twin of 
Sony cameras.
Virtual Camera actor reproduces the 
characteristics of a Sony camera, including 
the Look, by performing signal processing 
equivalent to that of a real Sony camera. In 
the pre-vis process, it is possible to create 
images in the same way as when using a Sony 
camera.
The camera settings also correspond to the 
same items as a Sony camera.
For VENICE series cameras, you can quickly 
reproduce the image creation of a real VENICE 
camera in the pre-vis process by transferring 
Virtual VENICE settings to an actual VENICE 
camera using the Camera Control Panel in the 
on-set (shooting) process.
In addition, a moiré alert function can predict 
the occurrence of moiré, even in the pre-vis 
process, where there is no real camera or LED 
display.

On-set Camera component

The On-set Camera component is an Unreal 
Engine component that adds the necessary 
functions for virtual production by associating 
it with the Unreal Engine standard Cine 
Camera actor used for nDisplay in-camera VFX.
You can also calibrate the color characteristics 
of a Sony camera and LED display to 
reproduce colors as intended using the 
Camera Control Panel (VENICE series only), for 
configuring camera settings over a network, 
and the “Color Calibrator” application (option). 
The On-set Camera component functions 
facilitate efficient color workflows during the 
on-set (shooting) process.
It also supports an LED grading function, 
allowing you to adjust the brightness and 
color of HDR video output to an LED display.
In addition, the moiré alert function can 
predict the occurrence of moiré in shooting 
environments where it would be difficult to 
see.

Camera Control Panel

The Camera Control Panel is a function for 
checking and changing settings on a real 
VENICE camera from Unreal Engine via a 
network.
The image creation from the pre-vis process 
can be reproduced in the on-set (shooting) 
process by transferring Virtual VENICE settings 
to a real VENICE camera. You can also transfer 
settings from a real VENICE camera to Virtual 
VENICE to restart the pre-vis process using 
the same settings. Sharing settings between 
the pre-vis process and the on-set (shooting) 
process helps improve the work efficiency in 
each process.
Furthermore, using the live camera sync 
function allows you to synchronize the camera 
settings and lens settings (PL-mount Cooke/i 
lens or E-mount lens only) between a real 

VENICE camera, the on-set (shooting) process 
Cine Camera actor, and Virtual VENICE. It 
supports automatic adjustment of the size 
of the inner frustum that is output to the LED 
display, depending on the real VENICE camera 
imager mode setting, and also allows the 
camera lens settings to be applied to the on-
set (shooting) process Cine Camera actor as an 
alternative to using a lens encoder.

Software Licenses

Camera and Display Plugin allows you to 
use all the functions provided in the pre-vis 
process free of charge. However, a watermark 
is embedded in the output video of a Virtual 
Camera actor.
The watermark in the pre-vis process can be 
removed and all functions provided in the 
on-set (shooting) process can be used by 
purchasing and installing the “Camera and 
Display Plugin License.”
The functions that are available in the pre-vis 
process and on-set (shooting) process vary 
depending on the camera model.
For details, see “Supported Functions of Each 
Camera Model” (page 41).
To use the plugin, an Internet connection is 
required when launched for the first time and 
every 28 days thereafter to access the license 
server. However, an Internet connection is not 
required for render nodes running nDisplay 
only.
For details, see “Operating Environment” 
(page 8).

Shared license
A single software license can be installed on 
only one computer. However, there is a shared 
license mechanism that allows you to use all 
of the features of the plugin simultaneously 
on multiple editor computers and nDisplay 
render nodes.
For details, see “Shared License” (page 43).

Purchasing a software license
For details about purchasing a software 
license, visit the following sites.

Global:
https://pro.sony/products/digital-cinema-
cameras/camera-and-display-plugin

https://pro.sony/products/digital-cinema-cameras/camera-and-display-plugin
https://pro.sony/products/digital-cinema-cameras/camera-and-display-plugin
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Japan:
https://www.sony.jp/professional/solution/
virtual-production/camera-and-display-plugin
Mainland China:
https://www.sonystyle.com.cn/professional/
products/professional-cameras/digital-
cinema-cameras-series/digital-cinema-
cameras/CameraandDisplayPlugin.html

For details about installing a software license, 
refer to the license installation guide.
The installation guide can be downloaded 
from the purchase site.

https://www.sony.jp/professional/solution/virtual-production/camera-and-display-plugin
https://www.sony.jp/professional/solution/virtual-production/camera-and-display-plugin
https://www.sonystyle.com.cn/professional/products/professional-cameras/digital-cinema-cameras-series/digital-cinema-cameras/CameraandDisplayPlugin.html
https://www.sonystyle.com.cn/professional/products/professional-cameras/digital-cinema-cameras-series/digital-cinema-cameras/CameraandDisplayPlugin.html
https://www.sonystyle.com.cn/professional/products/professional-cameras/digital-cinema-cameras-series/digital-cinema-cameras/CameraandDisplayPlugin.html
https://www.sonystyle.com.cn/professional/products/professional-cameras/digital-cinema-cameras-series/digital-cinema-cameras/CameraandDisplayPlugin.html
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Camera and Display Plugin Structure

Pre-vis process

Virtual Camera actor

[Functions]
•• Configure the camera device and LED display 
that will be used on-set to reproduce the 
color and framing in the output video

•• Operate the Virtual Camera actor on a tablet 
using the VCam function and check the 
output video (VENICE series, BURANO, FR7 
only)

•• Export/import Virtual Camera actor 
configuration to/from a file

•• Predict the occurrence of moiré

Camera 
configuration 
file

Cine Camera actor
(Unreal Engine standard 
virtual cinema camera)

Display chart for 
color calibration
Apply 3D LUT

Apply settings to real 
camera device
(VENICE series only)

Save settings of a 
camera device to a file
(VENICE series only) VENICE series

Shooting

LED display

Camera Control Panel

[Functions]
•• Control and configure VENICE series via web 
remote control

•• Import configuration file and apply to VENICE 
series

•• Export VENICE series settings to a file and 
apply to Virtual VENICE

•• Synchronize camera and lens settings 
between VENICE series, on-set (shooting) 
process Cine Camera actor, and Virtual 
VENICE (live camera sync function)

On-set Camera component

[Functions]
•• Perform color calibration of camera device 
and LED display

•• Adjust brightness and color of HDR video 
output to LED display

•• Predict the occurrence of moiré

On-set (shooting) process

Export configuration
Import configuration

Import 
configuration

(VENICE series 
only)

Link to 
camera actor

Display as camera 
for in-camera VFX
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Usage Precautions
Software Usage

This manual or the software described herein, 
in whole or in part, may not be reproduced, 
translated or reduced to any machine readable 
form without prior written approval from Sony 
Corporation.

© 2023, 2024 Sony Corporation

SONY CORPORATION PROVIDES NO 
WARRANTY WITH REGARD TO THIS MANUAL, 
THE SOFTWARE OR OTHER INFORMATION 
CONTAINED HEREIN AND HEREBY EXPRESSLY 
DISCLAIMS ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR PURPOSE WITH REGARD TO 
THIS MANUAL, THE SOFTWARE OR SUCH 
OTHER INFORMATION. IN NO EVENT SHALL 
SONY CORPORATION BE LIABLE FOR ANY 
INCIDENTAL, CONSEQUENTIAL OR SPECIAL 
DAMAGES, WHETHER BASED ON TORT, 
CONTRACT, OR OTHERWISE, ARISING OUT 
OF OR IN CONNECTION WITH THIS MANUAL, 
THE SOFTWARE OR OTHER INFORMATION 
CONTAINED HEREIN OR THE USE THEREOF.

This software may only be used with the 
specified device.

Sony Corporation reserves the right to make 
any modification to this manual or the 
information contained herein at any time 
without notice.

Security

SONY WILL NOT BE LIABLE FOR DAMAGES OF 
ANY KIND RESULTING FROM A FAILURE TO 
IMPLEMENT PROPER SECURITY MEASURES 
ON TRANSMISSION DEVICES, UNAVOIDABLE 
DATA LEAKS RESULTING FROM TRANSMISSION 
SPECIFICATIONS, OR SECURITY PROBLEMS OF 
ANY KIND.
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About This Manual
Trademarks

•• Windows and DirectX are trademarks 
or registered trademarks of Microsoft 
Corporation in the U.S. and/or other 
countries.

•• Unreal Engine is a trademark or registered 
trademark of Epic Games, Inc. in the United 
States of America and elsewhere.

•• AMD is a trademark of Advanced Micro 
Devices, Inc.

•• Intel is a trademark or registered trademark 
of Intel Corporation or its subsidiaries.

•• App Store and iPad are trademarks of 
Apple Inc., registered in the U.S. and other 
countries and regions.

•• The terms HDMI, HDMI High-Definition 
Multimedia Interface, HDMI Trade dress 
and the HDMI Logos are trademarks or 
registered trademarks of HDMI Licensing 
Administrator, Inc.

All system names, product names, and 
company names appearing in this document 
are registered trademarks or trademarks of 
their respective owners.
Trademarked items are not indicated by ® or ™ 
symbols in this document.

About the Display Screen

The displayed screen may vary from that 
shown in this document, depending on the 
computer and operating environment.
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Setup
This section describes how to install Camera 
and Display Plugin and enable the plugin in 
Unreal Engine.

Operating Environment

Operating conditions

To use the plugin, an Internet connection is 
required when launched for the first time and 
every 28 days thereafter to access the license 
server. However, an Internet connection is not 
required for render nodes running nDisplay 
only.
The proxy server for Internet connection uses 
the Windows OS proxy settings.

[Note]
The plugin is enabled for 28 days after accessing the 
license server.  
Note that when working offline, you will need to connect 
to the Internet and access the license server every 28 
days.

Recommended operating environment

OS: 
Windows 10 version 22H2 (64-bit)

CPU: 
Quad core Intel (4th generation Core or 
later) or AMD (Zen series or later), 2.5 GHz 
or higher

Memory: 
8 GB RAM or higher

Graphics card: 
DirectX 11 or DirectX 12 compatible 
graphics card

For in-camera VFX shooting
You must prepare an operating environment 
that is recommended by Epic Games, Inc.
For details, visit the Unreal Engine site by Epic 
Games, Inc.

Installing Camera and Display 
Plugin

This section describes how to install 
Camera and Display Plugin using the 
“CameraAndDisplayPlugin_xxxxx_yyyyy.msi” 
installer.
“xxxxx” in the file name indicates the version 
of the plugin and “yyyyy” indicates the version 
of Unreal Engine.

1	 Run “CameraAndDisplayPlugin_xxxxx_
yyyyy.msi.”
The setup wizard launches.
The software end user license agreement 
appears. Check the contents and place a 
check mark in [I accept the terms in the 
License Agreement] to proceed.

2	 Specify the installation destination folder.
Specify the folder in which to install the 
plugin on the installation destination 
folder selection screen.
If Unreal Engine is installed, by default the 
plugin will be installed directly in Unreal 
Engine.
“Unreal Engine installation folder\Engine\
Plugins” is displayed as the installation 
destination folder.

To install in an arbitrary folder
Change the folder on the installation 
destination folder selection screen.
If the plugin is installed in an arbitrary 
folder, copy the installation folder of the 
plugin to “Project_folder\Plugins” to 
reference the plugin from your project.

[Notes]
•• Even if Unreal Engine is installed, the Unreal 

Engine installation folder may not be detected 
properly. In this case, enter the folder path 
manually.

•• If you install the plugin directly into Unreal 
Engine and then copy the installation folder of 

the plugin to a project folder, the copy of the 
plugin in the project folder takes precedence.

3	 Follow the on-screen instructions to 
complete the installation.

Uninstalling

Run “CameraAndDisplayPlugin_xxxxx_yyyyy.
msi.”
The setup wizard launches. Follow the on-
screen instructions to uninstall the plugin.

Enabling Camera and Display 
Plugin

This section describes how to enable Camera 
and Display Plugin using the Unreal Engine 
editor (Unreal Editor) after installing the 
plugin.
You can enable/disable the plugin for each 
project.

1	 Select [Edit] > [Plugins] from the Unreal 
Editor menu bar.
The [Plugins] window appears.

2	 Select [INSTALLED].
A list of the installed plugins is displayed.

3	 Place a check mark in [Camera and 
Display Plugin].
A message appears prompting you to 
restart Unreal Editor.

To disable the plugin
Clear the check mark from [Camera and 
Display Plugin].

4	 Restart Unreal Editor when prompted.
The plugin is enabled.

To check the installation/enabled status
When the plugin is installed and enabled 
correctly, [Sony Virtual VENICE Actor] is 
displayed on the [Place Actors] panel of Unreal 
Editor.

[Note]
In addition to [Sony Virtual VENICE Actor], Virtual Camera 
actors of Sony cameras supported by the plugin are also 
displayed on the [Place Actors] panel.
For details, see “Virtual Camera actors” (page 10).
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Setting the Privacy Policy

When you open an Unreal Engine project with 
this plugin enabled, a window appears that 
prompts you to set the privacy policy.
You can also change the privacy policy 
setting by selecting [Tools] > [Privacy Policy 
Agreements] from the Unreal Editor menu bar.

[Note]
Depending on your country or region, agreement to 
some privacy policies is mandatory to use this plugin.
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Pre-Vis Process Operations
This section describes how to use the Virtual 
Camera actor of this plugin in pre-vis process 
operations.
You must instantiate a Virtual Camera actor 
using the Unreal Engine editor (Unreal Editor) 
and configure the instance for scouting and 
image creation.
The basic operations and workflow in the pre-
vis process are shown below.

Instantiating a Virtual Camera actor using 
Unreal Editor



Configuring Virtual Camera actor camera 
device/LED display



Configuring Virtual Camera actor post process



Configuring virtual scouting and image creation



Configuring the moiré alert function
(required if using moiré alert function)



Exporting a Virtual Camera actor configuration 
file
(required if creating a configuration file)



Exporting image files using Movie Render 
Queue
(required if rendering image files)



Switching Virtual Camera actor camera model
(required if changing model)

[Note]
A watermark is embedded in the output video of a 
Virtual Camera actor. A software license is required to 
remove the watermark.
For details, see “Software Licenses” (page 3).

Instantiating a Virtual Camera actor 
using Unreal Editor

Place a Virtual Camera actor into a level in 
the same way as the Unreal Engine standard 
camera actor using Unreal Editor to make it 
available for use.
For details about operation, see “Instantiating 
a Virtual Camera Actor” (page 11).

Virtual Camera actors
The following Virtual Camera actors are 
provided for use with Sony cameras supported 
by the plugin.
•• Sony Virtual VENICE Actor
•• Sony Virtual BURANO Actor
•• Sony Virtual FR7 Actor
•• Sony Virtual HDC-5500 Actor
•• Sony Virtual HDC-3500 Actor
•• Sony Virtual HDC-F5500 Actor

Configuring Virtual Camera actor camera 
device/LED display

Select the Virtual Camera actor placed into a 
level and configure each item on the [Details] 
panel.
In addition to the same configuration items for 
a Cine Camera actor, the [Details] panel shows 
the configuration items for the Virtual Camera 
actor in a Virtual Camera section specific to 
the Sony camera.
In [Camera Settings], select the camera type 
(VENICE series, HDC‑5500, HDC‑3500 only) and 
configure the filmback, frame rate, and other 
camera settings.
For VENICE series, BURANO, and FR7 Virtual 
Camera actors, enabling the [On-screen 

Display] setting allows you to adjust the 
camera settings and shooting area while 
displaying the settings and frame lines in the 
output video in the same way as a real camera 
device.
Also, set your LED display and the color space 
of the input signal in [LED Settings].
For details about configuration items, see 
“Virtual Camera Actor Configuration Items” 
(page 24) and refer to the manual for the 
camera device.

About Virtual Camera section names
The name of the section displaying 
configuration items for a Sony Virtual Camera 
actor will vary depending on the selected 
Virtual Camera actor.
The following section names are displayed 
according to the Virtual Camera actor.
•• Sony Virtual VENICE
•• Sony Virtual BURANO
•• Sony Virtual FR7
•• Sony Virtual HDC-5500
•• Sony Virtual HDC-3500
•• Sony Virtual HDC-F5500

Working color space
The plugin supports the following [Working 
Color Space] settings in an Unreal Engine 
project.

•• sRGB / Rec709

•• Rec2020

•• ACES AP0

•• ACES AP1 / ACEScg

•• P3DCI

•• P3D65

Configuring Virtual Camera actor post 
process

To reproduce the image creation made by 
the Virtual Camera actor during the pre-vis 
process in the on-set (shooting) process, the 

post process settings must match between 
the Virtual Camera actor, the on-set (shooting) 
process Cine Camera actor, and the post 
process volume.
For details about configuring the Virtual 
Camera actor post process, see “Configuring 
Post Process Settings” (page 12).
For details about configuring on-set (shooting) 
process Cine Camera actor post process 
and post process volume settings, see “Live 
Camera Sync Function (VENICE series only)” 
(page 21).

Configuring virtual scouting and image 
creation

After configuring a camera device, configure 
settings for virtual scouting and image 
creation.
In 3D assets, place the Virtual Camera actor in 
an appropriate position and adjust the lens 
settings.
The following virtual scouting methods are 
supported.
•• Adjust the Virtual Camera actor camera 

settings/lens settings using the VCam 
function of Unreal Engine (VENICE series, 
BURANO, FR7 only).  
For details about the VCam function, see 
“VCam Function (VENICE series, BURANO, 
FR7 only)” (page 12).

•• Adjust the camera settings/lens settings 
by operating a Virtual Camera actor using 
Unreal Editor.  
You can also link the Virtual Camera actor 
position and lens settings using a position 
tracker and lens encoder.  
For details about using a tracker, refer to the 
manual for the tracker.

The Virtual Camera actor also supports the 
Unreal Engine sequencer function. You can 
place a Virtual Camera actor in a created 
level sequence and save some of the settings 
of the Virtual Camera actor as a key frame, 
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allowing you to preview the output video from 
the camera device while managing multiple 
shots with different settings in the sequencer. 
For VENICE series, BURANO, and FR7 Virtual 
Camera actors, you can also create a level 
sequence using the VCam function.
For details about configuration items, see 
“Virtual Camera Actor Configuration Items” 
(page 24) and refer to the manual for the 
camera device.
For details about the sequencer function, visit 
the Unreal Engine site by Epic Games, Inc.

[Note]
The property names added to a level sequence may 
differ from the item names in the [Details] panel for the 
Virtual Camera actor.
For example, the value of the “EI for VENICE 2 8K - ISO 
800” property displayed in the sequencer may not be 
applied if [Camera Type] is set to [VENICE 2 6K] or if 
[Base ISO] is set to [3200].
You can add properties that correspond to the settings 
of the current Virtual Camera actor to a level sequence 
by adding properties from the [Details] panel.

Configuring the moiré alert function

In virtual production using an LED display, 
moiré (a phenomenon such as striped 
patterns and color shifts on the screen) may 
occur when the camera lens focus is close to 
the display surface.
You can enable the moiré alert function that 
can predict the occurrence of moiré during the 
pre-vis process.
For details about configuring, see “Moiré Alert 
Function” (page 37).

[Note]
If the current camera position/orientation and lens 
settings information cannot be acquired correctly, the 
moiré alert function will not produce correct results.
For details, see “Configuring a Camera and Lens” 
(page 37).

Exporting a Virtual Camera actor 
configuration file

You can export the settings configured for a 
Virtual Camera actor to a file.
You can restore settings by importing a 
created configuration file into a Virtual Camera 
actor.
If you are using the VENICE series, you can 
reproduce the same image creation as when 
virtual scouting during the pre-vis process in 
the on-set (shooting) process by applying the 
configuration file to a real camera device. You 
can also import a camera device configuration 
file created using the Camera Control Panel 
during the on-set (shooting) process into a 
Virtual Camera actor.
For details about operation, see “Exporting 
a Configuration File” (page 13) and 
“Importing a Configuration File” (page 14).

Exporting image files using Movie 
Render Queue

You can export a preview video of a level 
sequence created with the sequencer function 
as a sequence of still image files (*.jpg, *.png, 
*.bmp, etc.) using the Movie Render Queue 
function of Unreal Engine.
When rendering images using the Movie 
Render Queue function, configure the OCIO 
settings for the Virtual Camera actor so that 
the images are output with the appropriate 
color.
For details about configuring OCIO, see 
“Configuring OCIO Settings for Movie Render 
Queue” (page 14).
For details about the Movie Render Queue 
function, visit the Unreal Engine site by Epic 
Games, Inc.

Switching Virtual Camera actor camera 
model

You can change the camera model after 
adjusting the Virtual Camera actor position/
orientation, camera settings, and lens settings 
using a level sequence or other method.
For details about operation, see “Switching the 
Camera Model” (page 15).

Instantiating a Virtual Camera 
Actor

Placing a Virtual Camera actor into a level in 
Unreal Editor creates an instance.

1	 Select a Virtual Camera actor in the [Place 
Actors] panel of Unreal Editor.
Enter “Sony Virtual” in the search box on 
the [Place Actors] panel and select the 
Virtual Camera actor corresponding to 
your camera device.
For details about the names of actors, see 
“Virtual Camera actors” (page 10).

2	 Drag & drop the selected Virtual Camera 
actor into the viewport.
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Configuring Post Process Settings

Apply the standard post process settings for 
in-camera VFX to the Virtual Camera actor. 
You can configure all post process items at the 
same time.

1	 Click the [Bypass] button in [Post Process 
Override] in the Virtual Camera section in 
the [Details] panel for the Virtual Camera 
actor.

2	 Click the [OK] button in the confirmation 
message.
The items, excluding [Exposure], are 
configured with the recommended values 
for in-camera VFX.

3	 Configure the exposure in [Exposure].
The [Exposure] settings are optional.
Configure as follows, as required.
•• Place a check mark in [Metering Mode] 

and select [Manual].
•• Place a check mark in [Exposure 

Compensation] and configure the 
exposure compensation.

•• Place a check mark in [Apply Physical 
Camera Exposure] and clear the check 
mark from the checkbox on the right 
side.

VCam Function (VENICE series, 
BURANO, FR7 only)

When the VCam function of a Virtual Camera 
actor is enabled, you can operate/configure 
the Virtual Camera actor and check the output 
video from a tablet, such as an iPad.
Launching the “Unreal VCam (Live Link VCAM)” 
application on the tablet and establishing a 
network connection with Unreal Editor enables 
operation using the VCam function.
For details about Unreal VCam (Live Link 
VCAM), refer to the download site of the 
application.

[Notes]
•• This plugin provides unique support for Sony camera 

settings and configuration file operations as part of 
the VCam functionality. The other functions follow the 
VCam actor functions provided by Unreal Engine.  
For details, visit the Unreal Engine site by Epic Games, 
Inc.

•• When the VCam function is enabled, a camera actor 
with a “_Record” suffix is created separately for the 
target Virtual Camera actor. This camera actor is used 
to save camera settings in a level sequence.

1	 Select [Edit] > [Plugins] from the Unreal 
Editor menu bar.
The [Plugins] window appears.

2	 Enable the required plugins.
Select the following plugins and restart 
Unreal Editor when prompted.
•• VirtualCamera
•• VirtualCameraCore
•• Live Link
•• Take Recorder
•• Movie Render Queue

3	 Click the [Add VCam] button in [VCam] in 
the Virtual Camera section in the [Details] 
panel for the Virtual Camera actor.
The VCam component is added to the 
Virtual Camera actor.

4	 Enable the VCam function in the Virtual 
Camera actor.
Check that a check mark is placed in 
[Enable VCam] in [VCam].

5	 Select the viewport to display the VCam 
function output.
Select the viewport in [Target Viewport] in 
[VCam].

6	 Check the IP address of the computer that 
is running Unreal Editor.
Select [Pixel Streaming] in Unreal Editor 
and check the IP address displayed in 
[SIGNALLING SERVER URLS].

7	 Download the “Unreal VCam (Live Link 
VCAM)” application from the App Store to 
the tablet.

8	 Connect the tablet to the same local area 
network as the computer that is running 
Unreal Editor.

9	 Launch Unreal VCam (Live Link VCAM) on 
the tablet and connect to the IP address 
that you checked in step 6.
The output video of the Virtual Camera 
actor is displayed on the tablet.
The output (Virtual Camera actor output 
video and Unreal VCam (Live Link VCAM) 
control interface) of the VCam function is 
also displayed in the Unreal Editor 
viewport configured in step 5.
Check that the output video of the Virtual 
Camera actor changes in response to the 
tablet operations.
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Unreal VCam (Live Link VCAM) control 
interface

1.	 Camera setup menu
Displays the setup menu of the camera device.
Use to configure the lens, EI, ISO, ND filter, 
white balance, and other settings.
Configuration file operations
You can save/import a configuration file using 
the [CFG] button.
To save camera settings, select the save 
destination slot and tap/click the [SVE] button.
To import saved camera settings, select a slot 
and tap/click the [OPN] button.
The configuration file created using the 
[SVE] button is saved for each camera 
model and slot in “Project_folder\Plugins\
SonyCameraAndDisplayResources\
VCamConfig” on your computer.
You can also import a configuration file 
created using the VCam function into a Virtual 
Camera actor in Unreal Editor or into a real 
camera device (VENICE series only).

2.	 Bookmark function
Saves/recalls Virtual Camera actor camera 
position/orientation and camera settings.

3.	 Take Recorder function
Use for sequencer operations.

4.	 VCam menu
Displays the setup menu of the application.

Exporting to a level sequence (Take 
Recorder function)

You can record Virtual Camera actor 
operations and settings to a level sequence 
using the Take Recorder function of Unreal 
Engine, and export a preview video of the 
level sequence as image files using the Movie 
Render Queue function.
For details about configuring Movie Render 
Queue, see “Configuring OCIO Settings for 
Movie Render Queue” (page 14).
For details about the Take Recorder function 
and Movie Render Queue function, visit the 
Unreal Engine site by Epic Games, Inc.

1	 Tap/click the  (Record) button displayed 
at the bottom right of Unreal VCam (Live 
Link VCAM).
The [Take Recorder] panel and 
[Sequencer] panel are displayed in Unreal 
Editor.

2	 Tap/click  (Record) again to start 
recording to a level sequence.
The Virtual Camera actor operations and 
configuration are recorded to a level 
sequence.

3	 Change the camera settings and lens 
settings, as required.

4	 Tap/click  (Record) again to stop 
recording to a level sequence.

5	 Tap/click the level sequence button in the 
VCam menu on the right side.
A list of level sequences is displayed.

6	 Select the level sequence.
A preview of the output video of the 
Virtual Camera actor recorded in the level 
sequence is played back.

7	 Disable the VCam function in the Virtual 
Camera actor of Unreal Editor.
Clear the check mark from [Enable VCam] 
in [VCam] in the Virtual Camera section in 
the [Details] panel.

[Note]
When the VCam function is enabled, the preview 
video is not exported correctly to image files.

8	 Launch Movie Render Queue in the 
[Sequencer] panel of Unreal Editor and 
export the level sequence preview video 
as image files.

Exporting a Configuration File

You can export the settings configured for a 
Virtual Camera actor to a file.
If you are using the VENICE series, you can 
import a configuration file into a real camera 
device using the Camera Control Panel. You 
can reproduce the same image creation as the 
pre-vis process during the on-set (shooting) 
process by applying the pre-vis process 
settings to the camera device.
For details about importing a configuration 
file in the on-set (shooting) process, see 
“Importing a Configuration File (applying 
settings to a camera device) (VENICE series 
only)” (page 20).

1	 Click the [Export Config File] button in the 
Virtual Camera section in the [Details] 
panel for the Virtual Camera actor.

A settings information confirmation 
dialog appears.

2	 Check the settings information and click 
the [OK] button.

3	 Specify a folder and file name, then save 
the file.
A configuration file (*.vcfg) is created.

[Note]
You cannot save to the Content folder or subfolders 
within the Content folder in your Unreal Engine 
project folder. Specify a different folder.

When using User 3D LUT (VENICE series only)
When [Shooting] > [Look] is set to [User 3D 
LUT], you can use the same User 3D LUT 
settings for both the pre-vis process and the 
on-set (shooting) process by transferring both 
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the configuration file and the User 3D LUT 
CUBE file (*.cube) to the on-set (shooting) 
process.
Only VENICE 2 supports the transfer of CUBE 
files via a network. For VENICE, transfer CUBE 
files using an SD card.

[Note]
If transferring CUBE files over a network with VENICE 
2, the CUBE files must be saved in the “Project_folder\
Plugins\SonyCameraAndDisplayResources\User3DLUT” 
folder for User 3D LUTs or in the same folder as the 
configuration file.

Importing a Configuration File

You can restore settings by importing a 
configuration file created using the [Export 
Config File] button of a Virtual Camera actor.
When using the VENICE series, you can also 
import a camera device configuration file 
created using the Camera Control Panel into 
a Virtual Camera actor. This allows you to 
resume a pre-vis process workflow with the 
same settings as the on-set (shooting) process 
by applying the real camera device settings to 
the Virtual Camera actor.
For details about exporting a configuration 
file in the on-set (shooting) process, see 
“Exporting a Configuration File (saving 
camera device settings) (VENICE series only)” 
(page 21).

1	 Click the [Import Config File] button in the 
Virtual Camera section in the [Details] 
panel for the Virtual Camera actor.

2	 Select the configuration file (*.vcfg) to 
import.
The settings are applied to the Virtual 
Camera actor.

Configuring OCIO Settings for 
Movie Render Queue

You can export a preview video of a level 
sequence as image files using the Movie 
Render Queue function.
To export image files, configure the OCIO 
settings for the Virtual Camera actor in the 
[Movie Render Queue] window in Unreal 
Editor.
For details, visit the Unreal Engine site by Epic 
Games, Inc.

1	 Display the rendering settings window for 
the target level sequence.

2	 Click [+ Setting] and select [Color Output].
[Color Output] settings are added to the 
rendering settings window.
Configure OCIO in [Color Output] > [OCIO 
Configuration].

3	 Place a check mark in [Enable OCIO].
[OCIO Configuration] is enabled.

4	 Select [Sony_OCIO_v2] in [Configuration 
Source].
Click the input field of [Configuration 
Source] and select [Sony_OCIO_v2] from 
the list.

If [Sony_OCIO_v2] is not displayed
Click the  (Settings) icon and enable 
[Show Plugin Content] and [Show Engine 
Content].
[Sony_OCIO_v2] appears in the list and 
can be selected.

5	 Select [Source for Bypass] in [Transform 
Source].

6	 Select [Destination for Bypass] in 
[Transform Destination].

7	 Configure other rendering settings, as 
required.
When finished, click the [Accept] button 
to apply the settings.

8	 Execute rendering.
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Switching the Camera Model

You can change the model of a Virtual Camera 
actor camera device between “VENICE series, 
BURANO, FR7” and between “HDC‑5500, 
HDC‑3500, HDC-F5500.”

[Notes]
•• Switching the camera model in a Virtual Camera actor 

also changes the sequencer camera model setting.  
The Virtual Camera actor camera settings are 
inherited to the extent possible. Settings that cannot 
be inherited are reset to their default values and the 
corresponding level sequence track is also deleted.

•• Changing the camera model will delete components 
added to the Virtual Camera actor.

1	 Click the [Change Camera Model] button 
in [Camera Settings] in the Virtual Camera 
section in the [Details] panel for the 
Virtual Camera actor.

The [Change Camera Model] dialog 
appears.

2	 Select the model of camera device in 
[Camera Model].

3	 Specify the actor name in [Actor Name].
The default actor name is entered in 
[Actor Name].
Change the actor name, as required.

4	 Click the [OK] button.

5	 Click the [OK] button in the confirmation 
message.
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On-Set (Shooting) Process Operations
The on-set (shooting) process workflow uses 
the On-set Camera component provided by 
the plugin and the Camera Control Panel.
In the Unreal Engine editor (Unreal Editor), add 
the On-set Camera component to the Cine 
Camera actor used for nDisplay in-camera 
VFX and configure the camera device and LED 
display.
If you are using the VENICE series, you can also 
launch the Camera Control Panel and perform 
camera device operations via a network.
The basic operations and workflow in the on-
set (shooting) process are shown below.

Adding a component to a camera actor using 
Unreal Editor



Configuring On-set Camera component camera 
device/LED display



Configuring OCIO for nDisplay



Calibrating color of a camera device and LED 
display



Configuring LED grading



Importing a configuration file into a camera 
device (VENICE series only)
(required if applying a configuration file)



Configuring the live camera sync function 
(VENICE series only)
(required if synchronizing the camera settings/
lens settings)



Configuring the moiré alert function
(required if using moiré alert function)



Conducting on-set shooting

[Note]
A software license is required to use the plugin functions 
in the on-set (shooting) process.
For details, see “Software Licenses” (page 3).

Adding a component to a camera actor 
using Unreal Editor

You can add the On-set Camera component to 
the Unreal Engine standard Cine Camera actor 
and camera actors that have a Cine Camera 
component that are used for nDisplay in-
camera VFX.
For details about operation, see “Adding the 
On-set Camera Component” (page 17).

[Notes]
•• Some camera actors may not support the On-set 

Camera component even though they have a Cine 
Camera component.

•• A Virtual Camera actor can only be used in the pre-vis 
process. A Virtual Camera actor cannot be used by 
adding the On-set Camera component to the actor.

Configuring On-set Camera component 
camera device/LED display

Select the On-set Camera component in the 
[Details] panel of the camera actor, and set 
each item in [Camera Settings] in the [Sony On 
Set Camera] section.
Select your camera model in [Camera Model], 
select the camera type (VENICE series, 
HDC‑5500, HDC‑3500 only) in [Camera Type], 
and configure the filmback and other camera 
settings.
Also, set your LED display and the color space 
of the input signal in [LED Settings].
For details about configuration items, see “On-
set Camera component configuration items” 

(page 31) and refer to the manual for the 
camera device.

Working color space
The plugin supports the following [Working 
Color Space] settings in an Unreal Engine 
project.
•• sRGB / Rec709
•• Rec2020
•• ACES AP0
•• ACES AP1 / ACEScg
•• P3DCI
•• P3D65

Configuring OCIO for nDisplay

Depending on the color space of the input 
signal of the LED display, configure the OCIO 
settings of the nDisplay outer frustum and 
inner frustum associated with the camera 
actor with the attached On-set Camera 
component.
For details about configuring, see “Configuring 
OCIO for nDisplay” (page 18).

Calibrating color of a camera device and 
LED display

Select the On-set Camera component in 
the [Details] panel of the camera actor, 
and configure the color calibration items in 
[Calibration] in the [Sony On Set Camera] 
section.
You can calibrate the color characteristics of 
the camera device and LED display using a 
color chart or 3D LUT.
For details about configuration items, see “On-
set Camera component configuration items” 
(page 31).
For details about configuring, see “Calibrating 
Color” (page 18) and refer to the manual for 
Color Calibrator.

Configuring LED grading

You can adjust the brightness and color of 
HDR video output to an LED display.
For example, if you convert the brightness 
represented as 100% SDR in Unreal Engine 
to HDR for output to an LED display, the 
brightness will be about 100 nits with the 
default OCIO settings, which may not be 
bright enough to display an HDR image on the 
LED display.
The LED grading function increases the 
brightness gain of the HDR video for display 
on an LED display to improve visibility of the 
video. In addition, the brightness is gradually 
rolled off to prevent high-luminance areas 
from being clipped at the maximum display 
brightness of the LED display, making it 
possible to display high-quality HDR video 
that maintains the gradation of high-
luminance areas.
You can preview the final video captured 
by the camera device during the pre-vis 
process by applying the same settings as [LED 
Grading] of the On-set Camera component to 
[LED Grading] of the Virtual Camera actor.
For details about configuring, see “Configuring 
LED Grading” (page 19).

[Note]
The LED grading is an experimental feature. The 
specifications may change in future versions based on 
user feedback.

Importing a configuration file into a 
camera device (VENICE series only)

You can import a configuration file created 
by a Virtual Camera actor into a real camera 
device using the Camera Control Panel.
This allows you to reproduce the same image 
creation in the on-set (shooting) process as 
the virtual scouting performed in the pre-vis 
process by applying Virtual Camera actor 
settings to a camera device.
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You can also prepare multiple configuration 
files for switching the camera device settings 
according to the environment or other 
conditions.
You can also export the settings of a camera 
device used during the on-set (shooting) 
process to a file.
For details about operation, see “Importing 
a Configuration File (applying settings to 
a camera device) (VENICE series only)” 
(page 20) and “Exporting a Configuration 
File (saving camera device settings) (VENICE 
series only)” (page 21).

Configuring the live camera sync 
function (VENICE series only)

If you use a configuration file to configure 
matching camera device and camera actor 
settings, you will need to export and import 
a configuration file every time the camera 
settings change. Changes to the camera 
device settings may go unnoticed on the 
Unreal Editor side, resulting in inconsistencies 
in camera settings.
You can keep the camera settings 
synchronized between the camera device, on-
set (shooting) process Cine Camera actor, and 
pre-vis process Virtual Camera actor by using 
the live camera sync function of the Camera 
Control Panel. The live camera sync function 
can also be used as an alternative to a lens 
encoder by reflecting the lens settings of a 
camera device (focal length, aperture, focus 
distance) to the lens settings of the on-set 
(shooting) process Cine Camera actor.
For details about configuring, see “Live 
Camera Sync Function (VENICE series only)” 
(page 21).

[Notes]
•• In order to reflect the lens settings of a camera device 

in the lens settings of a camera actor, the camera 
device must be equipped with a lens that supports 
the display of lens settings information (focal length, 
aperture, focus distance).  

Also, the synchronization of lens settings is supported 
only when using PL-mount Cooke/i lenses or E-mount 
lenses. 

•• You can operate multiple camera devices 
simultaneously by launching multiple instances of 
the Camera Control Panel. However, the same camera 
device or camera actor cannot be configured as 
the sync target from multiple Camera Control Panel 
instances.

•• The live camera sync function does not guarantee 
realtime synchronization of camera settings and lens 
settings. This function is intended for automatically 
synchronizing lens and camera settings for each 
shooting environment, not for changing lens settings 
while recording video.

Configuring the moiré alert function

You can enable the moiré alert function that 
can predict the occurrence of moiré that may 
be difficult to see in the on-set shooting 
environment.
For details about configuring, see “Moiré Alert 
Function” (page 37).

[Note]
If the current camera position/orientation and lens 
settings information cannot be acquired correctly, the 
moiré alert function will not produce correct results.
For details, see “Configuring a Camera and Lens” 
(page 37).

Conducting on-set shooting

Launch nDisplay and conduct on-set shooting.
Operations using the plugin are supported, 
even after launching nDisplay, using the multi-
user editing function of Unreal Engine.
If you are using the VENICE series, you can 
configure and operate a real camera device 
using the web remote control in the Camera 
Control Panel.
For details about launching the Camera 
Control Panel, see “Launching the Camera 
Control Panel (VENICE series only)” 
(page 19).

Adding the On-set Camera 
Component

You can add the On-set Camera component to 
the Unreal Engine standard Cine Camera actor 
and camera actors that have a Cine Camera 
component that are used for nDisplay in-
camera VFX.

[Notes]
•• Some camera actors may not support the On-set 

Camera component even though they have a Cine 
Camera component.

•• A Virtual Camera actor can only be used in the pre-vis 
process. A Virtual Camera actor cannot be used by 
adding the On-set Camera component to the actor.

1	 Select the target camera actor to 
configure in the [Outliner] panel of Unreal 
Editor.

2	 Click the [+ Add] button in the [Details] 
panel of the camera actor.

A list of components that can be selected 
is displayed.

3	 Select [Sony On Set Camera] from the list 
of components.

The On-set Camera component is added 
to the camera actor.
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Calibrating Color

You can calibrate the color of the camera 
device and LED display using the Color 
Calibrator application (option).
For details, refer to the manual for Color 
Calibrator.

1	 Select the On-set Camera component in 
the [Details] panel of the camera actor.

2	 Place a check mark in [Display Chart] in 
[Calibration] in the [Sony On Set Camera] 
section.
[Display Chart] is enabled and a color 
calibration chart is displayed in the 
nDisplay inner frustum.

3	 Set [Chart Type] and [Chart Scale] in 
[Calibration] by referring to the Color 
Calibrator manual.

[Note]
When setting [Calibration], disable [Calibration 
LUT].

4	 Shoot the chart using the camera device 
to generate a 3D LUT CUBE file (*.cube) 
using Color Calibrator.

5	 Click the [Add] button for [LUT Filename] 
in [Calibration LUT] and select the CUBE 
file generated in step 4.
The selected CUBE file is added to the 
[LUT Filename] drop-down list.

6	 Select the CUBE file added in step 5 from 
the [LUT Filename] drop-down list in 
[Calibration LUT].

7	 Place a check mark in [Enable] in 
[Calibration LUT].
[Calibration LUT] is enabled and the 

settings for the selected CUBE file are 
applied.

8	 Copy the CUBE file to the render node 
folder.
The CUBE file added in step 5 is saved in 
the “Project_folder\Plugins\
SonyCameraAndDisplayResources\
Calibration_LUT” folder.
Copy the CUBE file to the same folder of 
the render node.

[Note]
If the CUBE file is not copied correctly to the render 
node, the inner frustum image that is output by the 
render node will be displayed in grayscale when 
[Calibration LUT] is enabled.

If LED display controller settings are changed 
after a CUBE file is generated
When [LED Type] is set to [Crystal LED 
B-series], you can adjust the [Contrast], 
[Brightness], [Light Output], and [Color 
Temperature] items of [Crystal LED B-series 
Settings] in [Calibration LUT].
You can apply color calibration without 
regenerating a CUBE file by setting [Crystal 
LED B-series Settings] to the same values as 
the changed settings.
When [LED Type] is set to other than [Crystal 
LED B-series] and [Input Color Space] is SDR 
([SDR (sRGB/G2.4)] or [SDR (sRGB/G2.2)]), 
color shifts may occur if you change the peak 
luminance of the LED display controller to a 
value different from when color calibration 
was performed, depending on the type of LED 
display controller. It is recommended that you 
perform color calibration again with the new 
peak luminance setting.
When [LED Type] is set to other than [Crystal 
LED B-series] and [Input Color Space] is HDR 
([HDR (Rec.2020/PQ)] or [HDR (ACEScg/PQ)]), 
it will be necessary to regenerate a CUBE 
file each time you change the LED display 
controller settings.

Configuring OCIO for nDisplay

Configure the OCIO settings of the nDisplay 
outer frustum and inner frustum associated 
with the camera actor with the attached On-
set Camera component.
When OCIO settings are executed, appropriate 
values are applied automatically according to 
the color space of the LED display input signal.

Preparation
First, the files required for the nDisplay render 
node must be transferred.
For each project, copy the contents of the 
following folders from the computer running 
Unreal Editor to the nDisplay render node.
•• Project_folder\Plugins\

SonyCameraAndDisplayResources
•• Project_folder\Content\

SonyCameraAndDisplay

1	 Select the On-set Camera component in 
the [Details] panel of the camera actor.

2	 Click the [nDisplay OCIO Setting] button in 
[LED Settings] > [Input Color Space] in the 
[Sony On Set Camera] section.

The [nDisplay OCIO Setting] dialog 
appears.
When OCIO settings are executed, each 
item is set to the following values.
•• Status: 

“Enabled” 
nDisplay Root actor > [Enable Viewport 
OCIO] and ICVFXCamera > [Enable Inner 
Frustum OCIO] are set to [Enabled].

•• OCIO Asset: 
“Sony_OCIO_v2”

•• Source: 
Sets the same value as the [Working 
Color Space] setting in the Unreal 
Engine project.  
The On-set Camera component 
supports the following [Working Color 
Space] settings.
–– sRGB / Rec709
–– Rec2020
–– ACES AP0
–– ACES AP1 / ACEScg
–– P3DCI
–– P3D65

•• Destination: 
Sets the color space of the LED display 
input signal ([Input Color Space] 
setting).

•• Setting execution target: 
A check mark is automatically inserted 
for any nDisplay instances whose 
current settings differ from the values 
above to select them as a target for 
execution.

[Note]
If you clear the check mark for a setting execution 
target nDisplay, the color of the output video may 
vary from the expected color.

3	 Click the [Overwrite] button.

4	 Click the [OK] button in the confirmation 
message.
The OCIO settings are executed.
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Configuring LED Grading

You can adjust the brightness and color 
of the HDR video output to an LED display 
when [Input Color Space] is set to HDR ([HDR 
(Rec.2020/PQ)] or [HDR (ACEScg/PQ)]) in [LED 
Settings] in the On-set Camera component.
After adjustment of the inner frustum video, 
apply the adjustment results to the outer 
frustum.

Configuring the inner frustum LED 
grading

You can adjust the brightness and color while 
viewing the inner frustum video displayed on 
an LED display.

1	 Select the On-set Camera component in 
the [Details] panel of the camera actor.

2	 Place a check mark in [Enable LED 
Grading] in [LED Grading] in the [Sony On 
Set Camera] section.

3	 Set the brightness gain in [Linear Gain].
When set to the default value of 4.0, the 
brightness represented by SDR 100% in 
Unreal Engine is displayed at a brightness 
of approximately 400 nits on an LED 
display.

4	 Set the brightness roll-off in [Roll-off 
Luminance (Nit)].
Adjust the gradation of high-luminance 
areas based on the maximum brightness 
that the LED display can display.
When set to the default value of 1500, the 
high-luminance area is adjusted to fit 
within 1500 nits.

5	 Adjust the color in [ASC CDL].
Set each [ASC CDL] item, as required, to 
adjust the saturation in high-luminance 
areas and the gradations of dark areas.

Configuring the outer frustum LED 
grading

You can apply the inner frustum adjustment 
results to the outer frustum.

[Notes]
•• If the inner frustum LED grading settings are changed, 

reconfigure the outer frustum LED grading settings.
•• If OCIO LUT is updated using the [Update LUT] button, 

the outer frustum [Destination] setting displayed in 
the [nDisplay OCIO Settings] dialog changes.  
For example, when [HDR (Rec.2020/PQ)] is selected in 
[LED Settings] > [Input Color Space], the [Destination] 
setting changes from [Rec.2020/PQ] to [Rec.2020/PQ 
w LED grade].

1	 Exit the multi-user edit function session 
and the nDisplay running on the render 
node.

2	 Select the On-set Camera component in 
the [Details] panel of the camera actor.

3	 Click the [Update LUT] button in [LED 
Grading] in the [Sony On Set Camera] 
section.
The inner frustum adjustment results are 
applied to the nDisplay outer frustum 
OCIO LUT.

4	 Transfer the adjustment results to the 
nDisplay render node.
Copy the contents of the “Project_folder\
Content\SonyCameraAndDisplay” and 
“Project_folder\Plugins\
SonyCameraAndDisplayResources” 
folders to the nDisplay render node.

5	 Launch the multi-user edit function 
session and nDisplay.

6	 Place a check mark in [Apply LED Grade 
LUT in Outer Frustum OCIO] in [LED 
Grading] in the [Sony On Set Camera] 
section.
The LED grading settings are applied to 
the outer frustum using the OCIO LUT.

To save LED grading settings as a 3D LUT 
CUBE file
Click the [Export LED Grade] button.

Launching the Camera Control 
Panel (VENICE series only)

Open the Camera Control Panel from Unreal 
Editor and log in to the camera device.
After logging in, the camera device is 
connected and the web remote control and 
settings information of the camera device are 
displayed.
You can run up to four Camera Control Panel 
instances to connect to different camera 
devices.

[Note]
The Camera Control Panel is intended to be connected 
to a camera device on a local network. The proxy 
settings in Windows OS cannot be used.

1	 Open the Camera Control Panel.
Open the Camera Control Panel using one 
of the following methods. When you open 
the Camera Control Panel, the [Sony 
Camera Control Panel] window appears.
•• Select the On-set Camera component 

in the [Details] panel of the camera 
actor, select [Sony Camera Control Panel 
1] to [Sony Camera Control Panel 4] in 
[Camera Settings] in the [Sony On Set 
Camera] section.

•• Select [Window] > [Sony Camera Control 
Panel] > [Sony Camera Control Panel 1] 
to [Sony Camera Control Panel 4] from 
the Unreal Editor menu bar.
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2	 Enter the IP address of your camera 
device in [Camera IP Address] and click 
the [Connect] button.

3	 Enter the user name and password of the 
camera device and click the [Login] 
button.
Enter the user name configured for the 
camera device in [Username] and the 
password in [Password].
After logging in, the web remote control 
of the camera device is displayed on the 
[Camera Control] tab. 
You can check the settings information of 
the camera device on the [Details] tab.
You can configure the live camera sync 
function on the [Live Camera Sync] tab.

For details, see “[Sony Camera Control 
Panel] Window” (page 34).
For details about operation using the web 
remote control, refer to the manual for 
the camera device.

To disconnect a camera device
Click the [Disconnect] button.

Importing a Configuration File 
(applying settings to a camera 
device) (VENICE series only)

You can import a configuration file created 
by a Virtual Camera actor into a real camera 
device.
This allows you to reproduce the same image 
creation in the on-set (shooting) process as in 
the pre-vis process by applying Virtual Camera 
actor settings to a real camera device.
For details about exporting a configuration 
file in the pre-vis process, see “Exporting a 
Configuration File” (page 13).
You can also re-import a configuration file 
created using the [Save Configuration] button 
in the Camera Control Panel.

1	 Launch the Camera Control Panel.
For details about operation, see 
“Launching the Camera Control Panel 
(VENICE series only)” (page 19).

2	 Click the [Configure Camera] button in the 
[Sony Camera Control Panel] window.

3	 Select the configuration file (*.vcfg) to 
import.
The [Configure Camera] dialog appears in 
which you can check the settings 
information.
For details, see “[Configure Camera] 
dialog” (page 35).

4	 Click the [OK] button in the [Configure 
Camera] dialog.

5	 Click the [Yes] button in the confirmation 
message.
The settings are applied to the camera 
device.

[Notes]
•• Some items, such as lens settings and LED 

display settings, cannot be set automatically. 
Items that cannot be set are displayed in a list 
after the configuration file is imported. Configure 
each device manually, as required.  
Only VENICE 2 supports ASC CDL configuration 
via a network. For VENICE, create an ASC CDL 
file (*.cdl) using the [Generate CDL file] button 
and configure for the camera device using an 
SD card.  
For details, see “[Configure Camera] dialog” 
(page 35).

•• To use a User 3D LUT, only VENICE 2 supports the 
transfer of CUBE files via a network. For VENICE, 
transfer CUBE files using an SD card.  
CUBE files for transfer must be saved 
in the “Project_folder\Plugins\
SonyCameraAndDisplayResources\User3DLUT” 
folder for User 3D LUTs or in the same folder as 
the configuration file.  
You can open the folder for User 3D LUTs using 
the [Open User 3D LUT folder] button in the 
[Configure Camera] dialog.

•• When a configuration file is imported, the 
configuration file settings are applied to “Input 
Color Space” and “Look” on the camera device, 
but “LUT Select” is not configured automatically.  
You can reproduce the color specified in the 
configuration file by changing “LUT Select” to 
“Look” for the outputs of the camera device (SDI 
1/2, for example).  
Settings such as “Input Color Space,” “Look,” 
and “ASC CDL Process” applied to a camera 
device may differ from the values displayed in 
the [Configure Camera] dialog, but the signal 
processing that is applied will be equivalent.

Displaying a list of the configuration file 
settings information

You can display the settings of items saved in 
the configuration file.
When settings cannot be applied to a camera 
or other device via a network, you can 
configure the device manually while browsing 
the display.

1	 Select the On-set Camera component in 
the [Details] panel of the camera actor.
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2	 Click the [Camera Settings] > [Preview 
Config File] button in the [Sony On Set 
Camera] section.

3	 Select the configuration file (*.vcfg) to 
display.
The [Preview Configuration File] dialog 
appears. You can check the value of each 
item saved in the configuration file.
To close the [Preview Configuration File] 
dialog, click the [OK] button.

Exporting a Configuration File 
(saving camera device settings) 
(VENICE series only)

You can export the settings of a camera device 
used during the on-set (shooting) process to 
a file.
You can import a created configuration file 
into a Virtual Camera actor.
This allows you to resume a pre-vis process 
workflow with the same settings as the on-
set (shooting) process by applying the on-set 
(shooting) process settings to the Virtual 
Camera actor.
For details about importing a configuration 
file in the pre-vis process, see “Importing a 
Configuration File” (page 14).

1	 Launch the Camera Control Panel.
For details about operation, see 
“Launching the Camera Control Panel 
(VENICE series only)” (page 19).

2	 Click the [Save Configuration] button in 
the [Sony Camera Control Panel] window.
A settings information confirmation 
dialog appears.

3	 Check the settings information and click 
the [OK] button.

4	 Specify a folder and file name, then save 
the file.
A configuration file (*.vcfg) is created.

[Note]
You cannot save to the Content folder or subfolders 
within the Content folder in your Unreal Engine 
project folder. Specify a different folder.

Live Camera Sync Function 
(VENICE series only)

You can synchronize the lens settings and 
camera settings between a camera device 
and a camera actor using the live camera sync 
function.

[Notes]
•• You can operate multiple camera devices 

simultaneously by launching multiple instances of 
the Camera Control Panel. However, the same camera 
device or camera actor cannot be configured as 
the sync target from multiple Camera Control Panel 
instances.

•• The synchronization of lens settings is supported only 
when using PL-mount Cooke/i lenses or E-mount 
lenses.

Configuring the sync target camera actor

You can set the pre-vis camera actor and on-
set (shooting) process camera actor that will 
be synchronized using the live camera sync 
function.

[Note]
Depending on the application, you can specify only 
one camera actor to be synchronized (either the pre-vis 
process or on-set (shooting) process).

1	 Launch the Camera Control Panel.
For details about operation, see 
“Launching the Camera Control Panel 
(VENICE series only)” (page 19).

2	 Open the [Live Camera Sync] tab in the 
[Sony Camera Control Panel] window.

The IP address of the currently logged-in 
camera device is displayed in [Camera 
Device].
For details, see “[Live Camera Sync] tab” 
(page 36).

3	 Set the pre-vis process camera actor in 
[Pre-Vis Camera Actor].

Select the sync target Virtual Camera 
actor.

4	 Set the on-set (shooting) process camera 
actor in [On-set Camera Actor].

Select the sync target Cine Camera actor 
to which the On-set Camera component 
has been added.

If a warning mark is displayed for the 
camera type

A warning mark will be displayed if the 
camera type of [Pre-Vis Camera Actor], 
[On-set Camera Actor], and [Camera 
Device] do not match. Change the camera 
type in the [Details] panel for the camera 
actor so that they are all set to the same 
type.

Configuring the live camera sync 
function

Configure the live camera sync function 
synchronization for the intended purpose.

[Notes]
•• To use the multi-user edit function, you must join a 

multi-user session before configuring live camera 
function synchronization settings.
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•• If the camera device or camera actor settings are 
changed manually after configuring the sync mode 
using the [Change Sync Mode] button, the changed 
items will no longer be targeted for synchronization.  
If you configure the sync mode again using the 
[Change Sync Mode] button, all items will again be 
targeted for synchronization.

•• The live camera sync function synchronization 
settings are maintained even if you close the Camera 
Control Panel. To disable the synchronization settings, 
set the sync mode to [Off] using the [Change Sync 
Mode] button or disconnect the camera device from 
the network.

To synchronize the lens settings
You can reflect the lens settings of a camera 
device to the lens settings of a camera actor 
as an alternative to using a lens encoder.

[Note]
To synchronize the lens settings using the live camera 
sync function, disable the reception of settings 
information from a lens encoder.

1	 Check the sync target camera actor.
Check that the sync destination camera 
actors are specified in [Pre-Vis Camera 
Actor] and [On-set Camera Actor].

2	 Enable/disable synchronization for each 
[Lens] category item.
Enable/disable synchronization 
separately using the switch displayed on 
the left side of the [Iris], [Focal Length], 
and [Focus Distance] settings. Slide the 
switch to the right so that the color 
changes to blue to enable 
synchronization.

For example, to set the focus setting of 
the on-set (shooting) process camera 
actor to a fixed value, slide the [Focus 
Distance] switch in the [On-set Camera 
Actor] column to the left to disable 
synchronization.

3	 Click the [Change Sync Mode] button in 
the [Lens] category.

4	 Select the [Real To Virtual] radio button 
and click the [OK] button.

Synchronization starts.
If you change the lens settings on the 
camera device, check that the same 
setting is reflected on the camera actor 
lens.

To adjust the inner frustum size automatically
You can reflect the imager mode and 
other camera device settings on the on-set 
(shooting) process camera actor and adjust 
the size of the inner frustum displayed on the 
LED display automatically.

1	 Check the sync target on-set (shooting) 
process camera actor.
Check that the sync destination camera 
actor is specified in [On-set Camera 
Actor].

2	 Click the [Change Sync Mode] button in 
the [Camera] category.

3	 Select the [Real To Virtual] radio button 
and click the [OK] button.

Synchronization starts.
If you change the imager mode or other 
settings on the camera device, check that 
the same settings are reflected on the 
on-set (shooting) process camera actor 
and that the size of the inner frustum 
changes.

To reproduce the camera device image 
creation in the pre-vis process
You can reflect the camera settings of a 
camera device on the pre-vis process camera 
actor to reproduce the image creation of the 
camera device in the pre-vis process.

1	 Check the sync target pre-vis process 
camera actor.
Check that the sync destination camera 
actor is specified in [Pre-Vis Camera 
Actor].

2	 Click the [Change Sync Mode] button in 
the [Camera] category.

3	 Select the [Real To Virtual] radio button 
and click the [OK] button.

Synchronization starts.
If you change the camera settings (such 
as ND, white balance, Look) on the 
camera device, check that the same 
settings are reflected on the pre-vis 
process camera actor and that the output 
video brightness and color change.

[Note]
If a User 3D LUT is selected on the camera device, 
you can apply the User 3D LUT by making the same 
User 3D LUT CUBE file (*.cube) available to the pre-
vis process camera actor.

To reproduce the pre-vis process image 
creation on a camera device
You can reflect the camera settings of a pre-
vis process camera actor on a camera device 
to reproduce the image creation in the pre-vis 
process on the camera device.

1	 Check the sync target pre-vis process 
camera actor.
Check that the sync source camera actor 
is specified in [Pre-Vis Camera Actor].

2	 Click the [Change Sync Mode] button in 
the [Camera] category.

3	 Select the [Virtual To Real] radio button 
and click the [OK] button.
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Synchronization starts.
If you change the camera settings (such 
as ND, white balance, Look) on the pre-vis 
process camera actor, check that the 
same settings are reflected on the camera 
device and that the output video 
brightness and color change.

[Notes]
•• The project frame rate setting of a camera 

device is not synchronized. You can click the 
[Set] button to reflect the [Project Frame Rate] 
setting of a pre-vis process camera actor on the 
camera device.

•• Only VENICE 2 supports User 3D LUT and ASC 
CDL configuration via a network.  
For details about configuring VENICE, see 
“Importing a Configuration File (applying 
settings to a camera device) (VENICE series 
only)” (page 20).

•• The camera actor settings are applied to “Input 
Color Space” and “Look” on the camera device, 
but “LUT Select” is not configured automatically.  
You can reproduce the color specified in the 
camera actor by changing “LUT Select” to “Look” 
for the outputs of the camera device (SDI 1/2, for 
example).  
Settings such as “Input Color Space,” “Look,” and 
“ASC CDL Process” applied to a camera device 
may differ from the values displayed in [Device] 
on the [Live Camera Sync] tab, but the signal 
processing that is applied will be equivalent.

To synchronize post process settings
To reproduce the same image creation 
between a pre-vis process camera actor and a 
camera device, the post process settings must 
match between the pre-vis process camera 

actor, the on-set (shooting) process camera 
actor, and the post process volume.
You can synchronize the post process settings 
using the live camera sync function.

1	 Configure the post process on the pre-vis 
process camera actor.
Configure [Post Process Override] settings 
on the pre-vis process camera actor 
specified in [Pre-Vis Camera Actor].
For details, see “Configuring Post Process 
Settings” (page 12).

2	 If using a post process volume, select the 
target volume.
Place a check mark in [Overwrite Post 
Process Volume] in the [Post Process] 
category and select the target post 
process volume from the drop-down list 
on the right side.

[Note]
If the color of the outer frustum displayed on an 
LED display is not required to match the inner 
frustum, the check mark in [Overwrite Post Process 
Volume] is not required. However, the color of the 
inner frustum is dependent on the post process 
settings of the post process volume, so the image 
creation and color of the pre-vis process camera 
actor may not match.

3	 Click the [Copy Post Process of Pre-Vis 
Camera to On-set Camera] button.
The post process settings of the pre-vis 
process camera actor are copied to the 
on-set (shooting) process camera actor.
Check that the post process settings are 
reflected on the on-set (shooting) process 
camera actor.
If there is a check mark in [Overwrite Post 
Process Volume], check that the post 
process settings are also reflected on the 
post process volume.



24 4. Settings

Virtual Camera Actor Settings
In addition to the same configuration items for a Cine Camera actor, the [Details] panel of a Sony 
Virtual Camera actor displays a Virtual Camera section specific to the Sony camera.
The Virtual Camera section displays the following section names according to the selected 
Virtual Camera actor.
•• Sony Virtual VENICE
•• Sony Virtual BURANO
•• Sony Virtual FR7
•• Sony Virtual HDC-5500
•• Sony Virtual HDC-3500
•• Sony Virtual HDC-F5500

Configure the items for a Sony Virtual Camera actor in the Virtual Camera section.

Virtual Camera Actor Configuration Items

You can import/export configuration files and configure camera devices, the moiré alert function, 
LED displays, LED grading, and post process in the Virtual Camera section of the [Details] panel.

[Note]
If a software license has not been installed, an [Install License] button is displayed in the Virtual Camera section.

[Import Config File] button
Imports a camera device configuration file into a Virtual Camera actor.
You can import an on-set (shooting) process configuration file (VENICE series only) created using 
the Camera Control Panel or a configuration file created using the [Export Config File] button of a 
Virtual Camera actor.
For details about operation, see “Importing a Configuration File” (page 14).

[Export Config File] button
Exports a Virtual Camera actor configuration file.
If you are using the VENICE series, you can import a created configuration file into a real camera 
device using the Camera Control Panel.
For details about operation, see “Exporting a Configuration File” (page 13).

[Camera Settings]
Configures a camera device.
For details, see “[Camera Settings] configuration items” (page 24).

[Moiré Alert]
Configures the moiré alert function.
For details, see “[Moiré Alert] Configuration Items” (page 38).

[LED Settings]
Configures an LED display.
For details, see “[LED Settings] configuration items” (page 29).

[LED Grading]
Configures LED grading function settings.
For details, see “[LED Grading] configuration items” (page 30).

[Post Process Override]
Configures post process settings.
For details, see “[Post Process Override] configuration items” (page 30).

[Camera Settings] configuration items

Use to configure camera settings and lens settings according to your camera model.
For configuration items that are common to your camera device, you can set the same values as 
on the camera device.
For details about settings, refer to the manual for the camera device.

[Camera Settings] configuration items for VENICE series, BURANO, FR7

Item Description

[Change Camera Model] button Changes the model of the camera device.
You can switch between the following models.
•• VENICE series
•• BURANO
•• FR7

For details, see “Switching the Camera Model” (page 15).

Camera Type Displayed when the camera model is a VENICE series.
Sets the camera type.
The following types of VENICE series devices are supported.
•• VENICE (CineAltaV)
•• VENICE 2 6K (CineAltaV 2 6K)
•• VENICE 2 8K (CineAltaV 2 8K)

Camera ID Sets the ID of the camera device.
The camera ID is displayed as status information, depending 
on the [On-screen Display] setting.

VCam
Configures settings related to the VCam function.

Item Description

[Add VCam] button Adds a VCam component to a Virtual Camera actor.

[Delete VCam] button Deletes a VCam component from a Virtual Camera actor.

Enable VCam Enables/disables the VCam function.
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VCam
Configures settings related to the VCam function.

Item Description

Restore Transform when disabled Sets whether to restore camera position/orientation settings.
When a check mark is placed here, the camera position/
orientation settings in force before enabling the VCam 
function are stored and then will be restored when the VCam 
function is disabled.

Target Viewport Selects the Unreal Editor viewport to display the VCam 
function output.

Lens
Configures settings related to lenses.

Item Description

Lens Type Displayed when the camera model is a VENICE series or 
BURANO.
Sets the lens model.
The ranges for the [Iris (Current Aperture)], [Current Focal 
Length (mm)], and [Current Focus Distance] settings will vary 
depending on the lens model. The distortion and vignetting 
effects also change.
Supported lens models
•• Angenieux Super35 25-250mm
•• Canon CN-E20-50mm
•• Canon CN-E45-135mm
•• Canon CN8×15 IAS S
•• Canon CN8×15 IAS S (1.5× Extender)
•• FUJINON Premista19-45mm T2.9
•• FUJINON Premista28-100mm T2.9
•• FUJINON Premista80-250mm T2.9-3.5
•• FUJINON XK20-120mm T3.5
•• FUJINON ZK14-35mm T2.9
•• FUJINON ZK19-90mm T2.9
•• FUJINON ZK25-300mm T3.5-3.85
•• FUJINON ZK85-300mm T2.9-4.0
•• Zeiss Compact Prime CP.3 series
•• Zeiss Supreme Prime series

Iris (Current Aperture) Sets the aperture of the lens.
Can also be configured automatically using the [Auto-Adjust] 
button.

[Auto-Adjust] button Automatically sets the appropriate aperture according to the 
shutter, FPS, and ISO settings.

Current Focal Length (mm) Sets the focal length of the lens.

Current Focus Distance Sets the focus distance of the lens.

Lens
Configures settings related to lenses.

Item Description

Lens Simulation Displayed when the camera model is a VENICE series or 
BURANO. 
When [Lens Type] is not set to [Other], this sets whether to 
apply lens distortion and vignetting.

Enable Distortion Enables/disables distortion.

Enable Vignetting Enables/disables vignetting.

[Note]
To apply the vignetting effect correctly, place a check mark in 
[Vignette Intensity] under [Post Process] > [Lens] > [Image Effects] and 
set it to “0.0” in the [Details] panel of the Virtual Camera actor.

Optical Filter (Density Only) Sets the light attenuation (percentage of light transmission) 
according to the filter type.
Selecting [User] allows you to set an arbitrary value.

[Note]
The [Optical Filter (Density Only)] setting does not simulate the effect 
of light diffusion or the change in brightness due to the diffusion 
effect.

Optical Filter (User) Displayed when [Optical Filter (Density Only)] is set to [User].
Sets the light attenuation (percentage of light transmission).
Set value: Value in the range 0.00 to 1.00

Project
Configures basic settings for a project.
Corresponds to the Project menu of the camera device.
For details about items and settings in the Project menu, refer to the manual for the camera 
device.

Item Description

VENICE series:
Imager Mode
BURANO:
Imager Scan Mode
FR7:
Output Resolution

The configuration item varies depending on the camera 
model.
Sets the filmback of the Cine Camera component.

[Note]
For the VENICE series, depending on the [Imager Mode] setting, a 
warning message may appear indicating that a software license must 
be installed on the camera device, but Virtual Camera actor functions 
are always available for use.

VENICE series:
Project Frame Rate
BURANO, FR7:
Frequency

The configuration item varies depending on the camera 
model.
Sets the frame rate.

[Note]
The VENICE series frame rate of 47.95p is not supported.
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Project
Configures basic settings for a project.
Corresponds to the Project menu of the camera device.
For details about items and settings in the Project menu, refer to the manual for the camera 
device.

Item Description

VENICE series:
Input Color Space
BURANO, FR7:
Color Gamut

The configuration item varies depending on the camera 
model.
Sets the color space of the input signal.

Base ISO Sets the base sensitivity.

Noise Simulation Sets whether to simulate the generated noise due to the 
[Base ISO] and [Shooting] > [Exposure Index] settings for 
display in the output video.

Anamo. Desqueeze Displayed when the camera model is a VENICE series or 
BURANO.
Sets whether to perform de-squeeze processing of the 
output signal when using an anamorphic lens.
It sets the de-squeeze ratio of the de-squeeze processing.
Selecting [User] allows you to set an arbitrary value that is 
different from your camera device.

User Displayed when [Anamo. Desqueeze] is set to [User].
Sets the de-squeeze ratio.
Set value: Value in the range 1.0 to 2.0

[Note]
When [User] is selected, the de-squeeze ratio setting is not applied to 
the camera device.

Shooting
Configures settings related to shooting.
Corresponds to the Shooting menu of the camera device.
For details about items and settings in the Shooting menu, refer to the manual for the camera 
device.

Item Description

FPS Displays the same value as [Project] > [Project Frame Rate]/
[Frequency].

Shutter Sets the electronic shutter.

Mode Sets the operating mode of the electronic shutter.
Set value: Angle / Speed

Angle Displayed when [Mode] is set to [Angle].
Sets the opening angle of the electronic shutter.
If the camera model is a VENICE series, selecting [User] allows 
you to set an arbitrary value.

Shooting
Configures settings related to shooting.
Corresponds to the Shooting menu of the camera device.
For details about items and settings in the Shooting menu, refer to the manual for the camera 
device.

Item Description

User Displayed when [Angle] on a VENICE series is set to [User].
Sets the opening angle of the electronic shutter (equivalent 
to the setting when the electronic shutter operation is set to 
“Continuous” on your camera device).

Speed Displayed when [Mode] is set to [Speed].
Sets the speed of the electronic shutter.
If the camera model is a VENICE series, selecting [User] allows 
you to set an arbitrary value.

User (inverse) Displayed when [Speed] on a VENICE series is set to [User].
Sets the speed of the electronic shutter (equivalent to the 
setting when the electronic shutter operation is set to 
“Continuous” on your camera device).

ND Mode Displayed when the camera model is BURANO or FR7.
Sets the mode of the ND filter.
On BURANO, select from [Step], [Variable (Optical Density)], 
and [Variable (Transmittance)].
On FR7, select from [Step] and [Variable].

VENICE series:
ND
BURANO, FR7:
ND Value

The configuration item varies depending on the camera 
model.
Sets the ND filter position.

[Note]
On BURANO and FR7, the settings vary depending on the mode 
selected using [ND Mode].

Exposure Index Sets the EI value.

White Balance Sets the white balance.

Color Temp. Sets the color temperature.
Set value: 3200K / 4300K / 5500K / 6500K / User
Selecting [User] allows you to set an arbitrary value.

User Displayed when [Color Temp.] is set to [User].
Sets the color temperature.
Set value: Integer in the range 2000 to 15000

Tint Sets the tint value.
Set value: Integer in the range –99 to 99
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Shooting
Configures settings related to shooting.
Corresponds to the Shooting menu of the camera device.
For details about items and settings in the Shooting menu, refer to the manual for the camera 
device.

Item Description

VENICE series:
Look
BURANO, FR7:
Base Look

The configuration item varies depending on the camera 
model.
Sets the Look.
When [User 3D LUT] (VENICE series)/[User] (BURANO, FR7) is 
selected, you can load any CUBE file (*.cube) to use settings 
other than the preset Look settings for your camera device.

VENICE series:
User 3D LUT
BURANO, FR7:
User Base Look

The configuration item varies depending on the camera 
model.
Sets the CUBE file when [Look]/[Base Look] is set to [User 3D 
LUT]/[User].
Select the CUBE file to load from the drop-down list.
For details about CUBE files that can be loaded, refer to the 
manual for the camera device.

[Add] button Adds a CUBE file to the [User 3D LUT]/[User Base Look] 
drop-down list.

[Note]
Up to 32 CUBE files can be displayed in the drop-down list.

[Delete] button Deletes the CUBE file selected in [User 3D LUT]/[User Base 
Look].

ASC CDL Displayed when the camera model is a VENICE series.
Sets the ASC CDL.

Process Sets whether to apply ASC CDL to the output video.
When applying ASC CDL, set the ASC CDL processing 
sequence.
•• CDL Off: Do not apply ASC CDL to the output video.
•• Look -> CDL: Apply CDL after applying Look.
•• CDL -> Look: Apply CDL before applying Look.

[Import CDL File] button Loads an ASC CDL file (*.cdl) and applies the [Slope], [Offset], 
[Power], and [Saturation] parameters.

[Export CDL File] button Writes the [Slope], [Offset], [Power], and [Saturation] 
parameters to an ASC CDL file (*.cdl).

[Note]
The [Export CDL File] button function is used to export the ASC CDL 
parameter values configured by a Virtual Camera actor to third-party 
applications.
To apply the ASC CDL settings to your camera device, use a 
configuration file created using the [Export Config File] button. ASC 
CDL parameter values are included in configuration files.

Shooting
Configures settings related to shooting.
Corresponds to the Shooting menu of the camera device.
For details about items and settings in the Shooting menu, refer to the manual for the camera 
device.

Item Description

Slope Sets the slope (R, G, B).
Set value: Value in the range 0.000 to 3.999

Offset Sets the offset (R, G, B).
Set value: Value in the range –1.000 to 1.000

Power Sets the power (R, G, B).
Set value: Value in the range 0.400 to 4.000

Saturation Sets the saturation.
Set value: Value in the range 0.000 to 3.999

On-screen Display
Configures settings related to the on-screen display (OSD) embedded in the output video of the 
Virtual Camera actor.
The OSD setting is also applied to the camera actor output video of the VCam function.

Item Description

Status Info Sets the status information of the camera device.

Show Status Info Shows/hides the status information.

Focus Distance Format Sets the focus display method (units).
Set value: Meter / Feet

Frame Lines Sets the frame lines.
For details, refer to the manual for the camera device.

Show Frame Lines Shows/hides the frame lines.

Color Sets the color of frame lines.
Also applied to the color of the camera ID displayed as status 
information.
Set value: White / Yellow / Cyan / Green / Magenta / Red / 

Blue

Center Marker Shows/hides the center marker.

Picture Area Shows/hides the picture area marker (effective picture area).

Safety Zone Shows/hides the safety zone.
When shown, set the safety zone range (ratio).
Set value: 80% / 90% / 92.5% / 95%

Aspect Ratio Shows/hides the aspect marker.
When shown, set the aspect ratio of the aspect marker.
Set value: 17:9 / 16:9 / 15:9 / 14:9 / 13:9 / 9:16 / 4:3 / 1:1 / 

1.43:1 / 1.66:1 / 1.85:1 / 2:1 / 2.2:1 / 2.35:1 / 2.39:1

Aspect Ratio Type Sets the type of aspect marker.
Set value: Line / Mask / Line&Mask
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On-screen Display
Configures settings related to the on-screen display (OSD) embedded in the output video of the 
Virtual Camera actor.
The OSD setting is also applied to the camera actor output video of the VCam function.

Item Description

Mask Level Sets the brightness of the video outside the aspect marker 
when [Aspect Ratio Type] is set to [Mask] or [Line&Mask].
Set value: Integer in the range 0 to 15

Aspect Safety Zone Sets the safety zone range (ratio) of the aspect marker.
Set value: 80% / 90% / 92.5% / 95%

User Frame Line (Variable) Sets the user frame lines (arbitrary rectangular frame).

Show User Frame Line Shows/hides the user frame lines.

Width Sets the user frame line width (distance from the center to 
the left and right edges).
Set value: Integer in the range 3 to 480

Height Sets the user frame line height (distance from the center to 
the top and bottom edges).
Set value: Integer in the range 3 to 270

H Position Sets the horizontal position of the center of the user frame 
lines.
Set value: Integer in the range –477 to 477

V Position Sets the vertical position of the center of the user frame lines.
Set value: Integer in the range –267 to 267

[Camera Settings] configuration items for HDC‑5500, HDC‑3500, HDC-F5500

Item Description

[Change Camera Model] button Changes the model of the camera device.
You can switch between the following models.
•• HDC-5500
•• HDC-3500
•• HDC-F5500

For details, see “Switching the Camera Model” (page 15).

Camera Type Displayed when the camera model is HDC‑5500 or HDC‑3500.
Sets the camera type.
The following types of HDC‑5500 are supported.
•• HDC-5500
•• HDC-5500V

The following types of HDC‑3500 are supported.
•• HDC-3500
•• HDC-3500V

Item Description

Lens Sets the lens.

Lens Type Displayed when the camera model is HDC-F5500.
Sets the lens model.
The ranges for the [Iris (Current Aperture)], [Current Focal 
Length (mm)], and [Current Focus Distance] settings will vary 
depending on the lens model. The distortion and vignetting 
effects also change.
For details about supported lens models, see “Lens Type” 
(page 25).

Iris (Current Aperture) Sets the aperture of the lens.
Can also be configured automatically using the [Auto-Adjust] 
button.

[Auto-Adjust] button Automatically sets the appropriate aperture according to the 
shutter and frame rate settings.

Current Focal Length (mm) Sets the focal length of the lens.

Current Focus Distance Sets the focus distance of the lens.

Lens Simulation Displayed when the camera model is HDC-F5500.
When [Lens Type] is not set to [Other], this sets whether to 
apply lens distortion and vignetting.

Enable Distortion Enables/disables distortion.

Enable Vignetting Enables/disables vignetting.

[Note]
To apply the vignetting effect correctly, place a check mark in 
[Vignette Intensity] under [Post Process] > [Lens] > [Image Effects] and 
set it to “0.0” in the [Details] panel of the Virtual Camera actor.

System Format Sets the system format.

Resolution Sets the filmback of the Cine Camera component.

Frequency Sets the frame rate.

Color Sets the color space.
Only [BT.709] is configurable.

5600K Enables/disables electrical color temperature correction 
(5600K).

HDC-5500V, HDC-3500V:
ND (Inverse)
HDC-5500, HDC-3500, HDC-F5500:
ND

The configuration item varies depending on the camera 
model and type.
Sets the ND filter position.

CC Filter Sets the CC filter (color temperature conversion).
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Item Description

Shutter Sets the electronic shutter.

Mode Sets the operating mode of the electronic shutter.
Set value: Angle / Speed

Angle Displayed when [Mode] is set to [Angle].
Sets the opening angle of the electronic shutter.

Speed Displayed when [Mode] is set to [Speed].
Sets the speed of the electronic shutter.

White Balance Sets the white balance.

R Sets the white balance (R, G, B).
Set value: Integer in the range –99 to 99

[Note]
The default values are set to R “64” / G “0” / B “–79,” assuming the 
color temperature of Unreal Engine and the display is 6500K. To 
reproduce the same image creation on a real camera device, the 
5600K “On/Off” setting, CC filter setting, and white balance setting 
must be adjusted accordingly. 

G

B

Black (ABS) Sets the black level.

R Sets the black level (R, G, B).
Set value: Value in the range –99.0 to 99.0G

B

Master Sets the master black level.
Set value: Value in the range –99.9 to 99.9

Preset Matrix Sets a preset matrix.
Set: Off / ITU-709

Gain Sets the gain.

Step Gain Sets the step gain.
Set value: 12 dB / 9 dB / 6 dB / 3 dB / 0 dB / –3 dB / –6 dB

Master Gain (dB) Sets the master gain.
Set value: Value in the range –6.0 to 12.0

Total Gain Displays the sum value of all gains.

Noise Simulation Sets whether to simulate the generated noise due to gain 
settings for display in the output video.

Gamma Sets the gamma.
Set value: Off / Standard 1 to 7 / Hyper 1 to 4

Apply Knee Enables/disables the knee function.
Can be enabled only when [Gamma] is set to [Standard 1] to 
[Standard 7].

[LED Settings] configuration items

Select the model of your LED display and configure the color space of the input signal. If using 
the Crystal LED B-series, configure the LED display (Crystal LED B-series Settings) items.

Item Description

LED Type Sets the model of the LED display.

Input Color Space Sets the color space of the input signal of the LED display.
Set value: SDR / HDR / HDR (Rec.2020/PQ)

[Note]
The values that can be selected for [Input Color Space] will vary 
depending on the [LED Type] setting.

Sensitivity Simulation Sets the operating mode for luminance management.
•• Mode A: Operating mode that reflects the deviation in 

optical luminance that occurs between the LED display and 
camera device. The brightness of the output video changes 
depending on the display selected in [LED Type], similar to 
the actual shooting environment.

•• Mode B: Operating mode that does not reflect the 
deviation in optical luminance that occurs between the LED 
display and camera device. The brightness of the output 
video does not change depending on the display selected 
in [LED Type].

The type of color calibration varies depending on the 
selected operating mode.
For details, refer to the manual for Color Calibrator.

Luminance Adjustment Displayed when [Mode A] is selected in [Sensitivity 
Simulation].
Adjusts the luminance of the output video.
Set value: Value in the range 0.50 to 1.50

[Note]
The higher the value, the brighter the image.

Peak Luminance (Nit) Displayed when a display other than [Crystal LED B-series] is 
selected in [LED Type].
Sets the peak luminance.
Set value: Integer in the range 0 to 2000

[Note]
[Peak Luminance (Nit)] can be configured only when [Input Color 
Space] is set to [SDR].
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Crystal LED B-series Settings
Configures Crystal LED B-series display settings.
For details about settings, refer to the manual for the Crystal LED B-series.

[Note]
[Crystal LED B-series Settings] is displayed only when [Crystal LED B-series] is selected in [LED Type].

Item Description

Contrast Sets the contrast of the LED display.

Brightness Sets the brightness of the LED display.

Light Output Sets the optical output of the LED display.

Color Temperature Sets the color temperature of the LED display.
Selecting [User] allows you to set an arbitrary value for each 
parameter.

R Gain Displayed when [Color Temperature] is set to [User].
Sets the RGB gain.G Gain

B Gain

R Bias Displayed when [Color Temperature] is set to [User].
Sets the RGB bias.G Bias

B Bias

[LED Grading] configuration items

Adjusts the brightness and color of the HDR video output to an LED display when [Input Color 
Space] is set to HDR ([HDR] or [HDR (Rec.2020/PQ)]) in [LED Settings]. In general, you can preview 
the final video captured by the on-set (shooting) process during the pre-vis process by applying 
the same settings as [LED Grading] of the On-set Camera component.

Item Description

Enable LED Grading Enables/disables LED grading.

Linear Gain Sets the gain.
Set value: Value in the range 1.0 to 40.0

Roll-off Luminance (Nit) Sets the luminance roll-off (adjusts gradations of high-
luminance areas).
Set value: Integer in the range 1 to 10000

ASC CDL Sets the ASC CDL.

Slope Sets the slope (R, G, B).
Set value: Value in the range 0.000 to 3.999

Offset Sets the offset (R, G, B).
Set value: Value in the range –1.000 to 1.000

Power Sets the power (R, G, B).
Set value: Value in the range 0.400 to 4.000

Saturation Sets the saturation.
Set value: Value in the range 0.000 to 3.999

[Post Process Override] configuration items

Configures Virtual Camera actor post process settings. Clicking the [Bypass] button will 
automatically set all post process items (excluding [Exposure]) at the same time.
The settings of each item are the same as for the camera component [Post Process].

Item Description

[Bypass] button Sets settings, excluding [Exposure], to the recommended 
values for in-camera VFX.
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On-set Camera Component Settings
These settings configure the functions required for virtual production shooting for a camera actor 
with an attached On-set Camera component.
Select the On-set Camera component in the [Details] panel of the camera actor, and set items in 
the [Sony On Set Camera] section.

On-set Camera component configuration items

You can configure camera devices, LED displays, color calibration, LED grading, and moiré alert 
function settings in the [Sony On Set Camera] section of the [Details] panel.

[Note]
If a software license has not been installed, an [Install License] button is displayed in the [Sony On Set Camera] 
section.

[Camera Settings]
Configures a camera device and opens the Camera Control Panel (VENICE series only).
For details, see “[Camera Settings] configuration items” (page 31).

[LED Settings]
Configures an LED display and the OCIO settings for nDisplay.
For details, see “[LED Settings] configuration items” (page 32).

[Calibration]
Configures color calibration settings of a camera device and LED display.
For details, see “[Calibration] configuration items” (page 32).

[LED Grading]
Configures LED grading function settings.
For details, see “[LED Grading] configuration items” (page 33).

[Moiré Alert]
Configures the moiré alert function.
For details, see “[Moiré Alert] Configuration Items” (page 38).

[Camera Settings] configuration items

Select the model and type of your camera device and configure the filmback and other settings. 
If you are using the VENICE series, you can also open the Camera Control Panel.
For configuration items that are common to your camera device, you can set the same values as 
on the camera device.
For details about settings, refer to the manual for the camera device.

Item Description

[Camera Control Panel] button Opens the Camera Control Panel.
For details, see “Launching the Camera Control Panel (VENICE 
series only)” (page 19).

[Note]
The Camera Control Panel can be used only when the camera model is 
a VENICE series.

[Preview Config File] button Displays a list of settings information for a selected camera 
device configuration file.
You can select a configuration file created using the [Export 
Config File] button of a Virtual Camera actor.
If the camera model is a VENICE series, you can also select a 
configuration file created using the [Save Configuration] 
button in the Camera Control Panel. When settings cannot be 
applied to a camera or other device via a network, you can 
configure the device manually while browsing the display.

Camera Model Sets the model of the camera device.
The following models are supported.
•• VENICE series
•• BURANO
•• FR7
•• HDC-5500
•• HDC-3500
•• HDC-F5500

Camera Type Displayed when the camera model is a VENICE series, 
HDC‑5500, or HDC‑3500.
Sets the camera type.
The following types of VENICE series devices are supported.
•• VENICE (CineAltaV)
•• VENICE 2 6K (CineAltaV 2 6K)
•• VENICE 2 8K (CineAltaV 2 8K)

The following types of HDC‑5500 are supported.
•• HDC-5500
•• HDC-5500V

The following types of HDC‑3500 are supported.
•• HDC-3500
•• HDC-3500V

VENICE series:
Imager Mode
BURANO:
Imager Scan Mode
FR7, HDC‑5500, HDC‑3500, 
HDC-F5500:
Output Resolution

The configuration item varies depending on the camera 
model.
Sets the filmback of the Cine Camera component.
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Item Description

Anamo. Desqueeze Displayed when the camera model is a VENICE series or 
BURANO.
Sets the de-squeeze ratio when using an anamorphic lens.
Selecting [User] allows you to set an arbitrary value that is 
different from your camera device.

User Displayed when [Anamo. Desqueeze] is set to [User].
Sets the de-squeeze ratio.
Set value: Value in the range 1.0 to 2.0

[LED Settings] configuration items

Select the model of your LED display and configure the color space of the input signal. Also, 
configure the OCIO settings for nDisplay according to the color space of the input signal.

Item Description

LED Type Sets the model of the LED display.

Input Color Space Sets the color space of the input signal of the LED display.
Set value: SDR (sRGB/G2.4) / SDR (sRGB/G2.2) /  

HDR (Rec.2020/PQ) / HDR (ACEScg/PQ)

[Note]
The values that can be selected for [Input Color Space] will vary 
depending on the [LED Type] setting.

[nDisplay OCIO Setting] button Configures the OCIO settings of the nDisplay outer frustum 
and inner frustum associated with the camera actor with the 
attached On-set Camera component.
Clicking the [nDisplay OCIO Setting] button will display the 
[nDisplay OCIO Setting] dialog.
For details, see “Configuring OCIO for nDisplay” (page 18).

[Calibration] configuration items

Configure color calibration settings using a color chart (Calibration Chart) or 3D LUT (Calibration 
LUT).

Calibration Chart
Configures settings for the color chart used for color calibration by the Color Calibrator application 
(option).
For details, refer to the manual for Color Calibrator.

Item Description

Display Chart Shows/hides the color chart.

Chart Type Sets the type of the color chart.

Chart Scale Sets the size of the color chart.

Calibration LUT
Configures 3D LUT settings used for color calibration.

Item Description

LUT Filename Sets the CUBE file (*.cube) of the 3D LUT.
Select the CUBE file to load from the drop-down list.

[Add] button Adds a CUBE file to the [LUT Filename] drop-down list.

[Note]
Up to 32 CUBE files can be displayed in the drop-down list.

[Delete] button Deletes the CUBE file selected in [LUT Filename].

Enable Enables/disables 3D LUT operation.

[Note]
When calibrating color by displaying a color chart, first disable 
[Calibration LUT].

Crystal LED B-series Settings Displayed when [Crystal LED B-series] is selected in [LED 
Settings] > [LED Type].
Use when changing the color of a Crystal LED B-series display 
after a CUBE file is generated.
For details, see “If LED display controller settings are changed 
after a CUBE file is generated” (page 18).
For details about settings, refer to the manual for the Crystal 
LED B-series.

Contrast Sets the contrast of the LED display.

Brightness Sets the brightness of the LED display.

Light Output Sets the optical output of the LED display.

Color Temperature Sets the color temperature of the LED display.
Selecting [User] allows you to set an arbitrary value for each 
parameter.

R Gain Displayed when [Color Temperature] is set to [User].
Sets the RGB gain.G Gain

B Gain

R Bias Displayed when [Color Temperature] is set to [User].
Sets the RGB bias.G Bias

B Bias
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[LED Grading] configuration items

Adjusts the brightness and color of the HDR video output to an LED display when [Input Color 
Space] is set to HDR ([HDR (Rec.2020/PQ)] or [HDR (ACEScg/PQ)]) in [LED Settings].
For details about configuring, see “Configuring LED Grading” (page 19).

Item Description

Enable LED Grading Enables/disables LED grading.

Linear Gain Sets the gain.
Set value: Value in the range 1.0 to 40.0

Roll-off Luminance (Nit) Sets the luminance roll-off (adjusts gradations of high-
luminance areas).
Set value: Integer in the range 1 to 10000

ASC CDL Sets the ASC CDL.

Slope Sets the slope (R, G, B).
Set value: Value in the range 0.000 to 3.999

Offset Sets the offset (R, G, B).
Set value: Value in the range –1.000 to 1.000

Power Sets the power (R, G, B).
Set value: Value in the range 0.400 to 4.000

Saturation Sets the saturation.
Set value: Value in the range 0.000 to 3.999

Apply LED Grade LUT in Outer Frustum 
OCIO

Enables/disables LED grading for the outer frustum.

[Update LUT] button Applies the adjustment results of LED grading to the outer 
frustum OCIO LUT.

[Note]
To maintain consistent LED grading adjustment results between the 
inner and outer frustum, you must apply the LED grading settings 
using the [Update LUT] button every time there are changes.

[Export LED Grade] button Saves LED grading settings as a 3D LUT CUBE file.
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Camera Control Panel
You can connect a real camera device, and perform camera device operations and display 
settings information via a network using the Camera Control Panel. Also, you can synchronize the 
camera settings and lens settings between a camera device and a camera actor using the live 
camera sync function.
For details about launching the Camera Control Panel, see “Launching the Camera Control Panel 
(VENICE series only)” (page 19).

[Note]
The Camera Control Panel can be used only when using the VENICE series.

[Sony Camera Control Panel] Window

When you log in to a real camera device using the Camera Control Panel, the web remote control 
and settings of the camera device are displayed in the [Sony Camera Control Panel] window.

1.	 Camera IP Address
Displays the IP address of the camera device.

2.	 [Camera Control] tab
Displays the web remote control of the camera 
device.
For details about operation using the web 
remote control, refer to the manual for the 
camera device.

3.	 [Configure Camera] button
Imports a camera device configuration file into 
a real camera device.
You can import a pre-vis process configuration 
file created using the [Export Config File] 
button of a Virtual Camera actor or a 
configuration file created using the [Save 
Configuration] button of the Camera Control 
Panel.
Click the [Configure Camera] button to display 
the [Configure Camera] dialog. Check the 
settings information in the [Configure Camera] 
dialog and then start importing.
For details about operation, see “Importing 
a Configuration File (applying settings to 
a camera device) (VENICE series only)” 
(page 20).

4.	 [Save Configuration] button
Exports the settings of a real camera device to 
a file.
You can import a created file into a Virtual 
Camera actor.
For details about operation, see “Exporting 
a Configuration File (saving camera device 
settings) (VENICE series only)” (page 21).

5.	 [Details] tab
Displays settings information for a camera 
device and lens.
For details, refer to the manual for the camera 
device.

6.	 [Live Camera Sync] tab
Configures the live camera sync function 
settings.
For details, see “[Live Camera Sync] tab” 
(page 36).

7.	 Time and model of camera device
Displays the time configured on the camera 
device and the type of camera.

8.	 Connection status
Displays the connection status with the 
camera device.

9.	 [Connect] button / [Disconnect] button
Connects to a camera device. The [Connect] 
button is displayed when not connected to a 
camera device.
Disconnects from a camera device. The 
[Disconnect] button is displayed when 
connected to a camera device.
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[Configure Camera] dialog

When importing a configuration file into a camera device, the [Configure Camera] dialog appears 
in which you can check the settings information.

The following information is displayed in the 
[Configure Camera] dialog.
•• Camera Type: Type of camera
•• Setting: Configuration item
•• Configuration File: Set value in configuration 

file
•• Device: Current set value of a camera device

The [Configuration File] set value is displayed 
highlighted if the configuration file and current 
setting of the camera device are different.
For items with “>” displayed between the 
[Configuration File] set value and the [Device] 
set value, the configuration file set value 
will be applied to the camera device upon 
importing.

For items where “>” is not displayed, even if 
the display is highlighted, the setting will not 
be applied automatically upon importing.

Importing a configuration file
Click the [OK] button in the [Configure Camera] 
dialog, then click the [Yes] button in the 
confirmation message.
Importing starts and the set values in the 
configuration file are applied to the camera 
device.
After importing, a dialog appears which 
displays a list of items that could not be 
applied automatically.
For items that could not be applied, configure 
manually on the camera device.
If you are using VENICE as the camera device, 
ASC CDL files (*.cdl) and User 3D LUT CUBE 
files (*.cube) must be transferred to the 
camera device via an SD card.
•• You can create an ASC CDL file (*.cdl) using 

the [Generate CDL file] button displayed in 
the dialog. You can apply the settings by 
loading the created ASC CDL file into VENICE 
via an SD card.

•• You can open the “Project_folder\Plugins\
SonyCameraAndDisplayResources\
User3DLUT” folder for User 3D LUTs using 
the [Open User 3D LUT folder] button 
displayed in the dialog. You can apply the 
settings by loading a CUBE file saved in the 
folder into VENICE via an SD card.



4. Settings: Camera Control Panel36

[Live Camera Sync] tab

You can synchronize the camera settings and lens settings between a camera device and a 
camera actor using the live camera sync function.
For details about operation, see “Live Camera Sync Function (VENICE series only)” (page 21).

1.	 Pre-Vis Camera Actor
Sets the sync target pre-vis process Virtual 
Camera actor.

2.	 On-set Camera Actor
Sets the sync target Cine Camera actor to 
which the On‑set Camera component has 
been added for the on-set (shooting) process.

3.	 Camera Device
Displays the IP address of the currently 
logged-in camera device.

4.	 Category items and settings
Displays the items and settings of the [Lens], 
[Camera], [LED], [LED Grading], and [Post 
Process] categories.
[Pre-Vis Camera Actor] column
Pre-vis process Virtual Camera Actor settings
[On-set Camera Actor] column
On-set (shooting) process Cine Camera actor 
settings
[Device] column
Camera device settings

[Lens] category
Displays lens settings.
The sync destination value is highlighted if the 
sync source and sync destination settings are 
different.
[Change Sync Mode] button
Sets the sync mode for lens settings.
Off: Disables synchronization of lens settings.
Real To Virtual: Applies the lens settings of a 

camera device to pre-vis process and on-
set (shooting) process camera actors.

Sync switches
Enables/disables synchronization separately 
using the switch displayed on the left side of 
the [Iris], [Focal Length], and [Focus Distance] 
settings.
Slide the switch to the right so that the color 
changes to blue to enable synchronization.

[Camera] category
Displays the camera settings.
The sync destination value is highlighted if the 
sync source and sync destination settings are 
different.
[Change Sync Mode] button
Sets the sync mode for camera settings.
Off: Disables synchronization of camera 

settings.
Virtual To Real: Applies the camera settings of 

the pre-vis process camera actor to the on-
set (shooting) process camera actor and 
camera device.

Real To Virtual: Applies the camera settings of 
a camera device to pre-vis process and on-
set (shooting) process camera actors.

[Set] button
When the sync mode in the camera settings 
is set to [Virtual To Real], the [Project Frame 
Rate] setting of the pre-vis process camera 
actor is not synchronized automatically.
You can click the [Set] button to apply the 
[Project Frame Rate] setting to the camera 
device manually.

[LED] category
Displays the LED display settings of the 
camera actors.
The LED display settings are not synchronized.
The on-set (shooting) process setting is 
highlighted if the pre-vis process and on-set 
(shooting) process settings are different.

[LED Grading] category
Displays the LED grading settings of the 
camera actors.
The LED grading settings are not synchronized.
The on-set (shooting) process setting is 
highlighted if the pre-vis process and on-set 
(shooting) process settings are different.

[Post Process] category
Displays the post process settings of the 
camera actors.
The post process settings are not 
synchronized.
The on-set (shooting) process setting is 
highlighted if the pre-vis process and on-set 
(shooting) process settings are different.
[Copy Post Process of Pre-Vis Camera to On-
set Camera] button
Copies the pre-vis process camera actor 
settings to the on-set (shooting) process 
camera actor.
[Overwrite Post Process Volume]
Enables overwriting of the post process 
volume settings when a check mark is placed 
here.
When the [Copy Post Process of Pre-Vis 
Camera to On-set Camera] button is clicked, 
the pre-vis process camera actor settings 
are also copied to the post process volume 
selected from the drop-down list on the right 
side.
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Moiré Alert Function
In virtual production, moiré may occur on 
the LED display, depending on the distance 
and angle between the LED display and the 
camera, and the settings of the camera lens.
The plugin has a moiré alert function that can 
be used in both the pre-vis process and on-set 
(shooting) process.
When the moiré alert function is enabled, 
it can predict the occurrence of moiré, even 
in the pre-vis process where there is no real 
camera or LED display. In addition, the moiré 
alert function can predict the occurrence of 
moiré in on-set shooting environments where 
it would be difficult to see.

Configuring a Camera and Lens

The camera position/orientation information 
and lens information (focal length, aperture, 
focus distance) required by the moiré alert 
function must be configured correctly in the 
camera actor.
If you are using the VENICE series, you can 
synchronize the lens information between 
a camera device and a camera actor using 
the live camera sync function of the Camera 
Control Panel.
You can report the correct values by using a 
position tracker and lens encoder, for example.

Pre-vis process
Set the camera and lens information, [Camera 
Type] (VENICE series, HDC‑5500, HDC‑3500 
only), and [Anamo. Desqueeze] (VENICE series, 
BURANO only) correctly in the Virtual Camera 
actor.

On-set (shooting) process
Configure settings so that the camera and 
lens information is reflected in the camera 
actor with an attached On-set Camera 
component, and set [Camera Model], [Camera 

Type] (VENICE series, HDC‑5500, HDC‑3500 
only), and [Anamo. Desqueeze] (VENICE 
series, BURANO only) of the On-set Camera 
component correctly.
On-set, operation in a configuration that 
does not reflect the lens information of a 
real camera device on the camera actor for 
nDisplay rendering is also possible. In this 
case, configure a camera actor dedicated to 
the moiré alert function and add the On-set 
Camera component to the camera actor. 
Configure settings so that the camera and lens 
information is reflected in the camera actor 
dedicated to the moiré alert function, and set 
[Camera Model], [Camera Type], and [Anamo. 
Desqueeze] of the On-set Camera component 
correctly.
The moiré alert function operates in Unreal 
Editor, so camera and lens information must 
be reported to Unreal Editor, not to the render 
node.

[Note]
A Virtual Camera actor can only be used in the pre-vis 
process. It is not necessary to add an On-set Camera 
component to a Virtual Camera actor.

Configuring the Moiré Alert 
Function

You can configure the moiré alert function of 
a Virtual Camera actor or the On-set Camera 
component.
When the moiré alert function is enabled, you 
can check if there is a risk of moiré occurring 
by the color displayed on the target LED 
display.

Pre-vis process
Select a Virtual Camera actor and configure 
using the following procedure in the Virtual 
Camera section of the [Details] panel.

On-set (shooting) process
Select the On-set Camera component in 
the [Details] panel of the camera actor, and 
configure using the following procedure in the 
[Sony On Set Camera] section.

1	 Click the [Moiré Alert] > [Add Display] 
button.

The [Moiré Alert Setup] dialog appears.
For details, see “[Moiré Alert Setup] 
dialog” (page 39).

2	 Select the target nDisplay actor to set in 
the [Moiré Alert Setup] dialog.
Placing a check mark in [Show nDisplays 
Only] will display the nDisplay actors only.
If an nDisplay actor is not available, you 
can also use a Static Mesh actor that 
mimics the display shape.

3	 Select meshes to construct an LED display.
Place a check mark in the target mesh to 
set.
If the displays are the same type, you can 
select the meshes of multiple displays at 
the same time.
If there are displays of different type, 
repeat steps 1 to 6 to configure each 
display.

[Note]
You can register up to six types of LED displays 
using the [Add Display] button.

4	 Select your LED display in [Display Panel 
Type Preset].
If you select [Other], set the pitch size in 
[LED Pitch Size].

5	 Click the [Add] button.

6	 Click the [OK] button in the confirmation 
message.
The display is registered.

7	 Place a check mark in [Moiré Alert] > 
[Enable Moiré Alert].
The moiré alert function is enabled.
A colored tile mesh is attached to the 
mesh selected in step 3 to show the moiré 
occurrence level.

Moiré alert display color

The selected mesh will be displayed in the 
following colors according to the moiré 
occurrence level.
Green: Possibility of visible moiré is low.
Yellow: Moiré may be visible, depending on 

the shooting and viewing conditions.
Red: Possibility of visible moiré is high.
Purple: The moiré alert function cannot be 

used because the focus position is behind 
the LED display.

[Note]
This function does not guarantee that moiré will not 
occur when green is displayed.
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Editing/deleting moiré alert function 
settings

A list of the registered displays is displayed in 
[Moiré Alert] > [Displays].
You can click the [Edit] button for a target 
display to display the [Moiré Alert Setup] 
dialog and edit the display settings.
Clicking the [Delete] button for a target display 
will delete the display.
You can also place a check mark in [Show 
Moiré Alert] for a target display to show/hide 
the moiré alert color.

[Moiré Alert] Configuration Items

In the pre-vis process, configure the moiré alert function in [Moiré Alert] in the Virtual Camera 
section of the [Details] panel.
In the on-set (shooting) process, configure the moiré alert function in [Moiré Alert] in the [Sony 
On Set Camera] section of the [Details] panel.

Item Description

Enable Moiré Alert Enables/disables the moiré alert function for a display 
registered using [Add Display].

[Note]
When using the moiré alert function with multiple camera actors, only 
the camera actor on which the moiré alert function was last enabled is 
itself enabled. The moiré alert function is disabled on all other camera 
actors.

Extra OLPF Displayed when the camera model is HDC‑5500 or HDC-3500 
and the type is HDC‑5500V or HDC‑3500V.
Enables/disables “EXTRA OLPF” for the CC filter.

Show Low Level Alert Sets whether to show/hide the moire alert function in green 
(possibility of moiré occurrence is low).
Clear the check mark to not display green.

Show Display Meshes Sets whether to show/hide the display meshes (displayed in 
gray).
Clear the check mark to not display meshes.

Show Out of Range Alert Sets whether to show/hide the moire alert function in purple 
(moiré alert function out of range).
Clear the check mark to not display purple.

Exposure of Alert Color Sets the exposure of the moiré alert function display color.
Set value: Value in the range –8.0 to 8.0

Opacity of Alert Color Sets the opacity of the moiré alert function display color.
Set value: Value in the range 0.0 to 1.0

Overscan Height Percentage Sets the range (height and width) outside the display mesh 
area for displaying a moiré alert warning.
Set value: Value in the range 0.0 to 50.0

[Note]
Moiré alert warnings outside the display mesh area are not included in 
the [Overall Moiré Alert Level] display.

Overscan Width Percentage
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Item Description

Overall Moiré Alert Level Displays the moiré occurrence level.
If the level varies depending on the mesh, it is displayed in 
the following order of priority.
•• High: Possibility of visible moiré is high.
•• Middle: Moiré may be visible, depending on the shooting 

and viewing conditions.
•• Out of Range: The moiré alert function is out of range 

because the focus position is behind the LED display.
•• Low: Possibility of visible moiré is low.
•• N/A: The moiré alert function is disabled.

Focus Distance Displays the focus distance of the camera device.

Distance to Display Displays the distance between the camera device and LED 
display (along the optical axis of the camera device).

[Add Display] button Adds a display for the moiré alert function.
Clicking the [Add Display] button displays the [Moiré Alert 
Setup] dialog.
For details, see “[Moiré Alert Setup] dialog” (page 39).

Displays Displays a list of the registered displays.
[Show Moiré Alert], [Edit] button, and [Delete] button are 
displayed for each display.

Show Moiré Alert Displays the color of the moiré alert for a display.
Clear the check mark to not display the moiré alert color.

[Edit] button Edits the settings of the display.
Clicking the [Edit] button displays the [Moiré Alert Setup] 
dialog.
For details, see “[Moiré Alert Setup] dialog” (page 39).

[Delete] button Deletes the display.

[Moiré Alert Setup] dialog

The [Moiré Alert Setup] dialog is used to add and edit displays that are the target of the moiré 
alert function.

5

1

2

4

3

1.	 Actor (display) selection area
Displays the actors within the project.
Select the actors targeted by the moiré alert 
function.
Placing a check mark in [Show nDisplays Only] 
will display only the nDisplay actors in the 
actor selection area.

[Note]
If you display the [Moiré Alert Setup] dialog using the 
[Edit] button in the list of displays, the actor selection 
area is not displayed.

2.	 Mesh selection area
Displays the meshes used to construct the 
selected actor.
Select the meshes targeted by the moiré alert 
function.
Clicking the [Select All] button will select all of 
the displayed meshes.
Clicking the [Deselect All] button will deselect 
all of the displayed meshes.

3.	 Display Panel Type Preset
Sets the model of the display.
If you select [Other], set the pitch size in [LED 
Pitch Size].

[Note]
[LED Pitch Size] is displayed only when [Other] is 
selected.
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4.	 [Add] button / [Edit] button
Registers displays.
If you display the [Moiré Alert Setup] dialog 
using the [Edit] button in the list of displays, 
the [Edit] button is displayed instead of the 
[Add] button.

5.	 [Cancel] button
Closes the [Moiré Alert Setup] dialog without 
registering/editing a display.
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Supported Functions of Each Camera Model
The functions supported by the plugin vary depending on the camera model.
The following table shows the functions supported by each camera model (“” indicates supported functions).

Virtual Camera actor
The pre-vis process functions can be used free of charge, but a watermark is embedded in the output video of a Virtual Camera actor.
Installation of a software license is required to remove the watermark.

[Note]
You can change the camera model using the [Change Camera Model] button after adjusting the Virtual Camera actor position/orientation, camera settings, and lens settings using a level sequence or other method.
For details about configuring, see “Switching the Camera Model” (page 15).

Item VENICE series BURANO FR7 HDC-5500 HDC-3500 HDC-F5500

Virtual Camera actor name Sony Virtual VENICE Actor Sony Virtual BURANO 
Actor

Sony Virtual FR7 Actor Sony Virtual HDC‑5500 
Actor

Sony Virtual HDC‑3500 
Actor

Sony Virtual HDC‑F5500 
Actor

Virtual Camera section name Sony Virtual VENICE Sony Virtual BURANO Sony Virtual FR7 Sony Virtual HDC‑5500 Sony Virtual HDC‑3500 Sony Virtual HDC‑F5500

[Camera Type] VENICE
VENICE 2 6K
VENICE 2 8K

– – HDC-5500
HDC-5500V

HDC-3500
HDC-3500V

–

Exporting/importing a configuration 
file

     

[VCam]   
[Camera Settings] camera settings

Settings related to Cine EI 
mode cameras

  

Settings related to system 
cameras

  

On-screen display settings   
[Camera Settings] lens settings

Aperture, focal length, and 
focus distance settings

     

Lens type, distortion, and 
vignetting settings

  

Filter light attenuation 
settings

  

[Moiré Alert]      
[LED Settings]      
[LED Grading]      
[Post Process Override]      
Sequencer function and Movie 
Render Queue function

     



5. Appendix: Supported Functions of Each Camera Model42

On-set Camera component
Installation of a software license is required to use the on-set (shooting) process functions.

Item VENICE series BURANO FR7 HDC-5500 HDC-3500 HDC-F5500

[Camera Model] VENICE Series BURANO FR7 HDC-5500 HDC-3500 HDC-F5500

[Camera Type] VENICE
VENICE 2 6K
VENICE 2 8K

– – HDC-5500
HDC-5500V

HDC-3500
HDC-3500V

–

Displaying configuration file 
information

     

[Camera Settings]      
[LED Settings]      
[Calibration]      
[LED Grading]      
[Moiré Alert]      

Camera Control Panel
Installation of a software license is required to use the Camera Control Panel functions. However, the web remote control function can be used free of charge.

Item VENICE series BURANO FR7 HDC-5500 HDC-3500 HDC-F5500

Web remote control 
(software license not 
required)

Importing a configuration file 
(applying camera settings)



Exporting a configuration File (saving 
camera settings)



Live camera sync function 
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Shared License
There is a shared license mechanism that allows you to use all of the features of the plugin 
simultaneously on multiple editor computers and nDisplay render nodes.
When you start an Unreal Engine project on a computer on which the software license of the 
plugin is installed, a shared license will be created or renewed in “Project_folder\Plugins\
SonyCameraAndDisplayResources.”
All the functions of the plugin are enabled for use on other computers by copying the project 
folder containing the shared license to another editor computer or nDisplay render node.

Camera and Display Plugin 
license

Project folder includes 
shared license

Computer for editor
Camera and Display Plugin functions 
available (14 days)

nDisplay render node
Camera and Display Plugin functions 
available (14 days)

Copy Copy

Computer for editor
Install license
Enabled shared license

Shared license expiry
A shared license expires 14 days after its creation or renewal date. If you wish to continue using 
the plugin, you will need to periodically renew your shared license.
Renew the shared license by launching your Unreal Engine project on the computer where the 
software license is installed, then re-copy the project folder to the other computer.
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Troubleshooting
Camera output color varies between pre-vis process and on-set (shooting) process
Review the following items if the output video color of a Virtual Camera actor and the output 
video color of a real camera device are different.

Cause Solution

nDisplay editor preview is being captured by a 
Virtual Camera actor.

You can hide the nDisplay editor preview by 
clearing the check mark from [Enable Editor 
Preview] in [Editor Preview] of the nDisplay actor.

Camera settings of a Virtual Camera actor and a 
real camera device are different.

Check that the camera settings of the Virtual 
Camera actor and the real camera device are the 
same.
If you are using the VENICE series, you can import 
a Virtual Camera actor configuration file using the 
Camera Control Panel and apply the camera 
settings of the Virtual Camera actor to the camera 
device (page 20). When you import a 
configuration file, the [Configure Camera] dialog 
is displayed. You can compare the Virtual Camera 
actor settings with the camera device settings in 
the dialog (page 35).
On the VENICE series, you can also synchronize 
the camera settings between a camera device 
and a Virtual Camera actor using the live camera 
sync function of the Camera Control Panel 
(page 21).
For a system camera (HDC series), the default 
values are set to R “64” / G “0” / B “–79” for the 
[White Balance] on a Virtual Camera actor, 
assuming the color temperature is 6500K. To 
reproduce the same image creation on a real 
camera device, the 5600K “On/Off” setting, CC 
filter setting, and white balance setting must be 
adjusted accordingly.

Lens settings of a Virtual Camera actor and a real 
camera device are different.

Check that the lens settings used by a Virtual 
Camera actor and the real camera device are the 
same.
If you are using the VENICE series, you can 
synchronize the lens settings between a camera 
device and a Virtual Camera actor using the live 
camera sync function of the Camera Control Panel 
(page 21). Unlike camera settings, lens settings 
cannot be applied to a camera device by 
importing a configuration file using the Camera 
Control Panel.
If you are using a camera device other than the 
VENICE series, lens settings can be configured 
manually or by using a lens encoder.

Cause Solution

Virtual Camera actor and real LED display 
controller settings are different.

Check that [LED Settings] of the Virtual Camera 
actor and the real LED display controller have the 
same settings.
If using the Crystal LED B-series, [Crystal LED 
B-series Settings] must have the same settings as 
the real LED display controller.
If using an LED display other than the Crystal LED 
B-series, a standard HDR signal/SDR signal must 
be output from the LED display. Also, for SDR, the 
peak luminance settings must match.

On-set Camera component and real LED display 
controller settings are different.

Check that [LED Settings] of the On-set Camera 
component and the real LED display controller 
have the same settings.
If [LED Settings] > [Input Color Space] or the 
Unreal Engine project [Working Color Space] is 
changed, the OCIO settings must be configured 
again using the [nDisplay OCIO Setting] button.
If using the Crystal LED B-series, [Calibration LUT] 
> [Crystal LED B-series Settings] must have the 
same settings as the real LED display controller.

In Unreal Editor, the post process settings or post 
process volume settings of a camera actor are 
different for the pre-vis process and on-set 
(shooting) process.

In Unreal Editor, match the post process/post 
process volume settings of the Virtual Camera 
actor and the on-set (shooting) process Cine 
Camera actor.
Specifically, the [Bloom], [Exposure], [Vignette 
Intensity], [Expand Gamut], and [Tone Curve 
Amount] settings must match.
Note that camera actors other than the Unreal 
Engine standard Cine Camera actor may have 
different default values.
If you are using the VENICE series, you can 
synchronize the pre-vis process and on-set 
(shooting) process post process settings using the 
live camera sync function of the Camera Control 
Panel (page 21).

[Color Grading] is enabled in the ICVFXCamera 
component of an nDisplay actor.

Color grading settings are applied only to the 
output video of a camera device capturing 
nDisplay output. To synchronize the color with the 
pre-vis process Virtual Camera actor output video, 
disable [Color Grading].
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Cause Solution

A Virtual Camera actor in Unreal Editor and the 
Cine Camera actor with attached On-set Camera 
component on a render node do not output video 
with the same rendering settings.

Check that the Virtual Camera actor in Unreal 
Editor and the Cine Camera actor with the 
attached On-set Camera component on a render 
node are outputting video with the same 
rendering settings.
Different settings, such as sublevels, lighting 
visibility, and camera position, may not output the 
same color.
In addition, rendering the output video of a 
Virtual Camera actor in the Movie Render Queue 
may produce video that is closer to that of a 
camera device.

OCIO is configured for the output video of a 
Virtual Camera actor used in the pre-vis process.

Similarly to a real camera device, a Virtual Camera 
actor controls the color of the output video using 
the camera settings and lens settings. Hence, 
there is no need to configure OCIO when viewing 
the video in a viewport.
Also, if you are using the VENICE series, BURANO, 
or FR7, you can output Log video as-is, such as 
S-Gamut3.Cine/SLog3 selected using [Input Color 
Space]/[Color Gamut], by setting [Look] to [Log]. 
Note that S-Log3 output from a computer via 
HDMI or other connector will be full range or legal 
range, depending on the computer video output 
settings.

When rendering the output video of a Virtual 
Camera actor in the Movie Render Queue, OCIO is 
not set correctly.

When OCIO is not set correctly, the output video 
rendered using Movie Render Queue may appear 
whiter than the video displayed in the viewport. 
Set OCIO correctly (page 14).

“RM/RCP Paint Control” is set to “On” on the real 
camera device.

The Virtual Camera actor does not support the 
paint functions of a remote control unit.
Set “RM/RCP Paint Control” to “Off” on the real 
camera device.

nDisplay output color is not displayed correctly on LED display
Review the following items if an LED display does not display colors as expected.

Cause Solution

The OCIO settings of an nDisplay are not 
transferred to the nDisplay render node.

Transfer the contents of the “Project_folder\
Plugins\SonyCameraAndDisplayResources” and 
“Project_folder\Content\SonyCameraAndDisplay” 
folders from the computer running Unreal Editor 
to the nDisplay render node. This operation must 
be implemented once only for each project.

Color calibration is not applied to the nDisplay inner frustum display
Review the following items if color is not calibrated correctly.

Cause Solution

The CUBE file specified in [LUT Filename] of 
[Calibration LUT] in Unreal Editor was not 
transferred to the nDisplay render node.

Transfer the contents of the “Project_folder\
Plugins\SonyCameraAndDisplayResources” folder 
from the computer running Unreal Editor to the 
nDisplay render node.

[Camera Options] > [Post Process Blend Weight] 
of the camera actor with an attached On-set 
Camera component is set to a value other than 
1.0.

When using a color calibration chart display and 
the color calibration function, set [Post Process 
Blend Weight] to 1.0.

Moiré alert is not displayed correctly
Review the following items if the moiré alert function does not operate correctly.

Cause Solution

The focus distance of the lens configured for the 
camera actor does not match the distance to the 
actual lens focus position.

The focus distance indicated by the focus ring of 
the lens or other means may not match the 
distance to the actual lens focus position.
Accurate prediction of the occurrence of moiré 
can be achieved by setting the distance to the 
actual lens focus position to the focus distance of 
the camera actor.

Unreal Engine is running on a remote desktop. Moiré alerts are not displayed correctly with the 
default viewport settings when running Unreal 
Engine on a remote desktop.
Moiré alerts can be displayed by executing 
[Disable Realtime Override] in the viewport 
options and then enabling [Realtime].
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